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Chapter 1 Overview 
This Chapter Contains: 

• An overview of GeneChip™ Expression Analysis. 

• A summary of the procedures covered in the remainder of the manual. 

Introduction and Objectives 
Welcome to the GeneChip™ Expression Analysis Technical Manual. This manual is a technical guide for using 
GeneChip™ expression analysis probe arrays. All protocols included in this manual have been used 
successfully by our scientists, or have been recommended by our collaborators during the development of 
particular products. The field of mRNA gene expression monitoring is rapidly evolving and periodic 
technical updates to this manual will reflect the newest protocols and information for using GeneChip™ 
probe arrays. This manual applies to all GeneChip™ 3’ eukaryotic arrays in cartridge format and 
GeneChip™ prokaryotic arrays in cartridge format. 

As an GeneChip™ user, your feedback is welcome. Contact our technical support team with any input on 
how we can improve this resource. 

Explanation of GeneChip™ Probe Arrays 
GeneChip™ probe arrays are manufactured using technology that combines photolithography and 
combinatorial chemistry.1,2 Up to 1.3 million different oligonucleotide probes are synthesized on each array. 
Each oligonucleotide is located in a specific area on the array called a probe cell. Each probe cell contains 
hundreds of thousands to millions of copies of a given oligonucleotide. 

Probe arrays are manufactured in a series of cycles. Initially, a glass substrate is coated with linkers 
containing photolabile protecting groups. Then, a mask is applied that exposes selected portions of the 
probe array to ultraviolet light. Illumination removes the photolabile protecting groups enabling selective 
nucleoside phosphoramidite addition only at the previously exposed sites. Next, a different mask is applied 
and the cycle of illumination and chemical coupling is performed again. By repeating this cycle, a specific 
set of oligonucleotide probes is synthesized with each probe type in a known location. The completed 
probe arrays are packaged into cartridges. 

During the laboratory procedure described in this manual, biotin-labeled RNA or DNA fragments referred 
to as the “target” are hybridized to the probe array. The hybridized probe array is stained with streptavidin 
phycoerythrin conjugate and scanned by the GeneArray™ Scanner or the GeneChip™ Scanner 3000. The 
amount of light emitted at 570 nm is proportional to the bound target at each location on the probe array. 

1 Sambrook, J., Fritsch, E.F., Maniatis, T. Molecular Cloning: A Laboratory Manual, v.1 Cold Spring Harbor Labo-ratory Press, 
Cold Spring Harbor, NY p 21-52 (1989). 

2 Visit our website for current GeneChi ™ p technology references. 
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GeneChip™ Expression Analysis Overview 
The following major steps outline GeneChip™ expression analysis: 

1. Target Preparation 

2. Target Hybridization 

3. Fluidics Station Setup 

4. Probe Array Washing and Staining 

5. Probe Array Scan 

6. Data Analysis 

Due to the differences in the RNA species between eukaryotic and prokaryotic organisms, different target 
labeling protocols have been optimized. Chapters 2 through 6 provide detailed protocols for target 
preparation, hybridization, array washing, and staining for eukaryotic and prokaryotic arrays, respectively. 
Refer to the sections in this manual for detailed protocols appropriate for your arrays. 

Step 1: Target Preparation 
This manual describes procedures using GeneChip™ reagent kits for preparing biotinylated target from 
purified eukaryotic and prokaryotic RNA samples suitable for hybridization to GeneChip™ expression 
probe arrays. For more information on these procedures, contact Technical Support. 

For eukaryotic samples, using protocols referenced in Chapter 2, double-stranded cDNA is synthesized 
from total RNA or purified poly-A messenger RNA isolated from tissue or cells. An in vitro transcription 
(IVT) reaction is then done to produce biotin-labeled cRNA from the cDNA. The cRNA is fragmented 
before hybridization. 

For prokaryotic samples, Chapter 4 describes a detailed protocol to isolate total RNA followed by reverse 
transcription with random hexamers to produce cDNA. After fragmentation by DNase I, the cDNA is end-
labeled with biotin by terminal transferase. 

Step 2: Target Hybridization 
A hybridization cocktail is prepared, including the fragmented target, and probe array controls. It is then 
hybridized to the probe array during a 16-hour incubation. The hybridization process is described in the 
respective sections for the different probe array types. Refer to Chapter 3 for hybridization of eukaryotic 
samples, and Chapter 5 for prokaryotic samples. 

Step 3: Fluidics Station Setup 
Specific experimental information is defined using Microarray Suite or GeneChip™ Operating Software 
(GCOS) on a PC-compatible workstation. The probe array type, sample description, and comments are 
entered and saved with a unique experiment name. The fluidics station is then prepared for use by priming 
with the appropriate buffers. Refer to the GeneChip™ Expression Wash, Stain and Scan User Manual, Pub. No. 
MAN0018114 (formerly Pub. No. 702731) for information on fluidics station setup for eukaryotic samples, 
and Chapter 6 for prokaryotic samples. For more information on the fluidics station, refer to the GeneChip™ 
Fluidics Station User’s Guide. 

Step 4: Probe Array Washing and Staining 
Immediately following hybridization, the probe array undergoes an automated washing and staining 
protocol on the fluidics station. The GeneChip™ Expression Wash, Stain and Scan User Manual, Pub. No. 
MAN0018114 (formerly Pub. No. 702731) provides information for eukaryotic samples, and Chapter 6 
provides information for prokaryotic samples. 
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Step 5: Probe Array Scan 
Once the probe array has been hybridized, washed, and stained, it is scanned. Each workstation running 
Microarray Suite or GCOS can control one scanner. The software defines the probe cells and computes an 
intensity for each cell. 

Each complete probe array image is stored in a separate data file identified by the experiment name and is 
saved with a data image file (.dat) extension. 

Review the scanner user’s manual for safety precautions and for more information on using the scanner. 

Step 6: Data Analysis 
The .dat image is analyzed for probe intensities; results are reported in tabular and graphical formats. 
Information on data analysis is provided in the enclosed GeneChip™ Expression Analysis: Data Analysis 
Fundamentals booklet (Pub. No. 701190). 

Precautions 
1. FOR RESEARCH USE ONLY; NOT FOR USE IN DIAGNOSTIC PROCEDURES. 

2. Avoid microbial contamination, which may cause erroneous results. 

 

All biological specimens and materials with which they come into contact should 
be handled as if capable of transmitting infection and disposed of with proper 
precautions in accordance with federal, state, and local regulations. This includes 
adherence to the OSHA Bloodborne Pathogens Standard (29 CFR 1910.1030) for 
blood-derived and other samples governed by this act. Never pipet by mouth. 
Avoid specimen contact with skin and mucous membranes.: 

3. Exercise standard precautions when obtaining, handling, and disposing of potentially carcinogenic 
reagents. 

4. Exercise care to avoid cross contamination of samples during all steps of this procedure, as this may 
lead to erroneous results. 

5. Use powder-free gloves whenever possible to minimize introduction of powder particles into sample 
or probe array cartridges. 

Terminology 
Probes The oligonucleotides on the surface of the probe arrays are called probes because they 

probe, or interrogate, the sample. 

Target The target is the labeled nucleic acid that is being interrogated. It is hybridized to the 
probes on the array. 

Probe Cell Specific areas on the probe array that contain oligonucleotides of a specific sequence. 
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Interfering Conditions 

 

Wear powder-free gloves throughout procedure. Take steps to minimize the 
introduction of exogenous nucleases. Water used in the protocols below is 
molecular biology grade (nuclease free). 

Proper storage and handling of reagents and samples is essential for robust performance. 

All laboratory equipment used to prepare the target during this procedure should be calibrated and 
carefully maintained to ensure accuracy, as incorrect measurement of reagents may affect the outcome of 
the procedure. 

Instruments 
The GeneChip™ Expression Analysis Technical Manual is designed for use in a system consisting of a Fluidics 
Station, a Hybridization Oven 640, and a Scanner. 

References 
1. Sambrook, J., Fritsch, E.F., Maniatis, T. Molecular Cloning: A Laboratory Manual, v.1 Cold Spring 

Harbor Laboratory Press, Cold Spring Harbor, NY p 21-52 (1989). 

2. Visit our website for current GeneChip™ technology references. 

Limitations 
• The results of the assay are dependent upon the quality of the input RNA, subsequent proper 

handling of nucleic acids and other reagents. 

• The results should be evaluated by a qualified individual. 

 

Do not store enzymes in a frost-free freezer. 
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Chapter 2 Eukaryotic Target Preparation 
This chapter contains: 

• Complete One-Cycle Target Labeling Assay with 1 to 15 µg of total RNA or 0.2 to 2 µg of poly-A 
mRNA 

• Complete Two-Cycle Target Labeling Assay with 10 to 100 ng of total RNA 

Introduction 
This chapter describes the assay procedures recommended for eukaryotic target labeling in expression 
analysis using GeneChip™ brand probe arrays. Following the protocols and using high-quality starting 
materials, a sufficient amount of biotin-labeled cRNA target can be obtained for hybridization to at least 
two arrays in parallel. The reagents and protocols have been developed and optimized specifically for use 
with the GeneChip™ system. 

Depending on the amount of starting material, two procedures are described in detail in this manual. Use 
the following table to select the most appropriate labeling protocol for your samples: 

Table 2.1 

Total RNA as 
Starting Material 

mRNA as 
Starting Material 

Protocol 

1 µg – 15 µg 0.2 µg – 2 µg One-Cycle Target Labeling 

10 ng – 100 ng N/A Two-Cycle Target Labeling 

The One-Cycle Eukaryotic Target Labeling Assay experimental outline is represented in Figure 2.1. Total 
RNA (1 µg to 15 µg) or mRNA (0.2 µg to 2 µg) is first reverse transcribed using a T7-Oligo(dT) Promoter 
Primer in the first-strand cDNA synthesis reaction. Following RNase H-mediated second-strand cDNA 
synthesis, the double-stranded cDNA is purified and serves as a template in the subsequent in vitro 
transcription (IVT) reaction. The IVT reaction is carried out in the presence of T7 RNA Polymerase and a 
biotinylated nucleotide analog/ribonucleotide mix for complementary RNA (cRNA) amplification and 
biotin labeling. The biotinylated cRNA targets are then cleaned up, fragmented, and hybridized to 
GeneChip™ expression arrays. 

For smaller amounts of starting total RNA, in the range of 10 ng to 100 ng, an additional cycle of cDNA 
synthesis and IVT amplification is required to obtain sufficient amounts of labeled cRNA target for analysis 
with arrays. The Two-Cycle Eukaryotic Target Labeling Assay experimental outline is also represented in 
Figure 2.1. After cDNA synthesis in the first cycle, an unlabeled ribonucleotide mix is used in the first cycle 
of IVT amplification. The unlabeled cRNA is then reverse transcribed in the first-strand cDNA synthesis 
step of the second cycle using random primers. Subsequently, the T7-Oligo(dT) Promoter Primer is used in 
the second-strand cDNA synthesis to generate double-stranded cDNA template containing T7 promoter 
sequences. The resulting double-stranded cDNA is then amplified and labeled using a biotinylated 
nucleotide analog/ribonucleotide mix in the second IVT reaction. The labeled cRNA is then cleaned up, 
fragmented, and hybridized to GeneChip™ expression arrays. 
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Figure 2.1 GeneChip™ Eukaryotic Labeling Assays for Expression Analysis 
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Reagents and Materials Required 
The following reagents and materials are recommendations and have been tested and evaluated by our 
scientists. Information and part numbers listed are based on U.S. catalog information. For supplier 
information, refer to the Supplier Reference List in Appendix F of this manual. 

 

Do not store enzymes in a frost-free freezer. 

Total RNA Isolation 
• TRIzol Reagent: P/N 15596-018, or QIAzol™ Lysis Reagent: QIAGEN, P/N 79306 

• RNeasy Mini Kit: QIAGEN, P/N 74104 

Poly-A mRNA Isolation 
• Oligotex Direct mRNA Kit (isolation of mRNA from whole cells): QIAGEN, P/N 72012, 72022, or 

72041 

• Oligotex mRNA Kit (isolation of mRNA from total RNA): QIAGEN, P/N 70022, 70042, or 70061 

• QIAshredder: QIAGEN, P/N 79654 (Required only for use with QIAGEN Oligotex Direct Kit) 

• DEPC-Treated Water: P/N 9920 

One-Cycle Target Labeling 
• GeneChip™ One-Cycle Target Labeling and Control Reagents: P/N 900493. A convenient package 

containing all required labeling and control reagents to perform 30 one-cycle labeling reactions. Each of 
these components may be ordered individually (described below) as well as in this complete kit. 
Contains: 

- 1 GeneChip™ IVT Labeling Kit (P/N 900449) 

- 1 GeneChip™ One-Cycle cDNA Synthesis Kit (P/N 900431) 

- 1 GeneChip™ Sample Cleanup Module (P/N 900371) 

- 1 GeneChip™ Poly-A RNA Control Kit (P/N 900433) 

- 1 GeneChip™ Hybridization Control Kit (P/N 900454) 

Two-Cycle Target Labeling 
• GeneChip™ Two-Cycle Target Labeling and Control Reagents: P/N 900494. A convenient package 

containing required labeling and control reagents to perform 30 two-cycle labeling reactions. Each of 
these components may be ordered individually (described below) as well as in this complete kit. 
Contains: 

- 1 GeneChip™ IVT Labeling Kit (P/N 900449) 

- 1 GeneChip™ Two-Cycle cDNA Synthesis Kit (P/N 900432) 

- 1 GeneChip™ Sample Cleanup Module (P/N 900371) 

- 1 GeneChip™ IVT cRNA Cleanup Kit (900547) 

- 1 GeneChip™ Poly-A RNA Control Kit (P/N 900433) 

- 1 GeneChip™ Hybridization Control Kit (P/N 900454) 

• MEGAscript™ High Yield Transcription Kit: P/N 1334 Purchased separately (2 kits required to 
complete 30 reactions) 
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Miscellaneous Reagents 
• 10X TBE: Cambrex, P/N 50843 

• Absolute ethanol (stored at –20°C for RNA precipitation; store ethanol at room temperature for use 
with the GeneChip™ Sample Cleanup Module and IVT cRNA Kit) 

• 80% ethanol (stored at –20°C for RNA precipitation; store ethanol at room temperature for use with 
the GeneChip™ Sample Cleanup Module) 

• SYBR Green II: Cambrex, P/N 50523; or Thermo Fisher P/N S7586 (optional) 

• Pellet Paint: Novagen, P/N 69049-3 (optional) 

• Glycogen: P/N 9510 (optional) 

• 3M Sodium Acetate (NaOAc): Sigma-Aldrich, P/N S7899 

• Ethidium Bromide: Sigma-Aldrich, P/N E8751 

• 1N NaOH 

• 1N HCl 

Miscellaneous Supplies 
• Sterile, RNase-free, microcentrifuge vials, 1.5 mL: USA Scientific, P/N 1415-2600 (or equivalent) 

• Micropipettors, (P-2, P-20, P-200, P-1000): Rainin Pipetman or equivalent 

• Sterile-barrier, RNase-free pipette tips (Tips must be pointed, not rounded, for efficient use with the 
probe arrays) Beveled pipette tips may cause damage to the array septa and cause leakage. 

• Mini agarose gel electrophoresis unit with appropriate buffers 

• UV spectrophotometer 

• Bioanalyzer 

• Non-stick RNase-free microfuge tubes, 0.5 mL and 1.5 mL: P/N12350 and P/N 12450, respectively 

Total RNA and mRNA Isolation for One-Cycle Target Labeling 
Assay 
Protocols are provided for preparing labeled cRNA from either total RNA or purified poly-A mRNA. It was 
found that results obtained from samples prepared by both of these methods are similar, but not identical. 
Therefore, to get the best results, it is suggested to only compare samples prepared using the same type of 
RNA material. 

Review precautions and interfering conditions in Chapter 1 

 

The quality of the RNA is essential to the overall success of the analysis. Since 
the most appropriate protocol for the isolation of RNA can be source 
dependent, we recommend using a protocol that has been established for the 
tissues or cells being used. In the absence of an established protocol, using 
one of the commercially available kits designed for RNA isolation is suggested. 

When using a commercial kit, follow the manufacturer’s instructions for RNA isolation. 
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Isolation of RNA from Yeast 

Total RNA 
Good-quality total RNA has been isolated successfully from yeast cells using a hot phenol protocol 
described by Schmitt, et al. Nucl Acids Res 18:3091-3092 (1990). 

Poly-A mRNA 
We recommend first purifying total RNA from yeast cells before isolating poly-A mRNA from total RNA. 
Good-quality mRNA has been successfully isolated from total RNA using QIAGEN’s Oligotex mRNA Kit. 
A single round of poly-A mRNA selection provides mRNA of sufficient purity and yield to use as a 
template for cDNA synthesis. Two rounds of poly-A mRNA selection will result in significantly reduced 
yield and are not generally recommended. 

Isolation of RNA from Arabidopsis 

Total RNA 
TRIzol Reagent from Invitrogen Life Technologies has been used to isolate total RNA from Arabidopsis. 
Follow the instructions provided by the supplier and, when necessary, use the steps outlined specifically 
for samples with high starch and/or high lipid content. QIAzol Lysis Reagent from QIAGEN can also be 
used. 

Poly-A mRNA 
Arabidopsis poly-A mRNA has been successfully isolated using QIAGEN’s Oligotex products. However, 
other standard isolation products are likely to be adequate. 

Isolation of RNA from Mammalian Cells or Tissues 

Total RNA 
High-quality total RNA has been successfully isolated from mammalian cells (such as cultured cells and 
lymphocytes) using the RNeasy Mini Kit from QIAGEN. 

If mammalian tissue is used as the source of RNA, it is recommended to isolate total RNA with a 
commercial reagent, such as TRIzol or QIAzol reagents. 

 

If going directly from TRIzol-isolated total RNA to cDNA synthesis, it may 
be beneficial to perform a second cleanup on the total RNA before 
starting. After the ethanol precipitation step in the TRIzol extraction 
procedure, perform a cleanup using the QIAGEN RNeasy Mini Kit. Much 
better yields of labeled cRNA are obtained from the in vitro 
transcription-labeling reaction when this second cleanup is performed. 

Poly-A mRNA 
Good-quality mRNA has been successfully isolated from mammalian cells (such as cultured cells and 
lymphocytes) using QIAGEN’s Oligotex Direct mRNA kit and from total RNA using the Oligotex mRNA 
kit. If mammalian tissue is used as the source of mRNA, total RNA should be first purified using a 
commercial reagent, such as TRIzol, and then using a poly-A mRNA isolation procedure or a commercial 
kit. QIAzol™ Lysis Reagent from QIAGEN can also be used. 
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Precipitation of RNA 

Total RNA 
It is not necessary to precipitate total RNA following isolation or cleanup with the RNeasy Mini Kit. Adjust 
elution volumes from the RNeasy column to prepare for cDNA synthesis based upon expected RNA yields 
from your experiment. Ethanol precipitation is required following TRIzol or QIAzol reagent isolation and 
hot phenol extraction methods. 

Poly-A mRNA 
Most poly-A mRNA isolation procedures will result in dilution of RNA. It is necessary to concentrate 
mRNA prior to the cDNA synthesis. 

Precipitation Procedure 
1. Add 1/10 volume 3M NaOAc, pH 5.2, and 2.5 volumes ethanol.* 

2. Mix and incubate at –20°C for at least 1 hour. 

3. Centrifuge at ≥12,000 x g in a microcentrifuge for 20 minutes at 4°C. 

4. Wash pellet twice with 80% ethanol. 

5. Air dry pellet. Check for dryness before proceeding. 

6. Resuspend pellet in DEPC-treated H2O. The appropriate volume for resuspension depends on the 
expected yield and the amount of RNA required for the cDNA synthesis. Read ahead to the cDNA 
synthesis protocol in order to determine the appropriate resuspension volume at this step. 

*Addition of Carrier to Ethanol Precipitations 
Adding carrier material has been shown to improve the RNA yield of precipitation reactions. 

• Pellet Paint 

Addition of 0.5 µL of Pellet Paint per tube to nucleic acid precipitations makes the nucleic acid pellet 
easier to visualize and helps reduce the chance of losing the pellet during washing steps. The pellet 
paint does not appear to affect the outcome of subsequent steps in this protocol; however, it can 
contribute to the absorbance at 260 nm when quantifying the mRNA. 

• Glycogen 

Addition of 0.5 to 1 µL of glycogen (5 mg/mL) to nucleic acid precipitations aids in visualization of 
the pellet and may increase recovery. The glycogen does not appear to affect the outcome of 
subsequent steps in this protocol. 

QUANTIFICATION OF RNA 
Quantify RNA yield by spectrophotometric analysis using the convention that 1 absorbance unit at 260 nm 
equals 40 µg/mL RNA. 

• The absorbance should be checked at 260 and 280 nm for determination of sample concentration and 
purity. 

• The A260/A280 ratio should be close to 2.0 for pure RNA (ratios between 1.9 and 2.1 are acceptable). 

• Integrity of total RNA samples can also be assessed qualitatively on an Agilent 2100 Bioanalyzer. 
Refer to Figure 2.2 for an example of good-quality total RNA sample. 
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Figure 2.2 Electropherogram (from the Agilent 2100 Bioanalyzer) for HeLa Total RNA. For a high-quality 
total RNA sample, two well-defined peaks corresponding to the 18S and 28S ribosomal RNAs should be 
observed, similar to a denaturing agarose gel, with ratios approaching 2:1 for the 28S to 18S bands. 

 

Total RNA Isolation for Two-Cycle Target Labeling Assay 
Several commercial kits and protocols are currently available for total RNA isolation from small samples 
(tissues, biopsies, LCM samples, etc.). Select the one that is suitable for processing of your samples and 
follow the vendor-recommended procedures closely since high-quality and high-integrity starting material 
is essential for the success of the assay. 

One-Cycle cDNA Synthesis1 
Step 1: Preparation of Poly-A-RNA Controls for One-Cycle cDNA 
Synthesis (Spike-In Controls 

Eukaryotic Poly-A RNA Control Kit is used for this step. 
Designed specifically to provide exogenous positive controls to monitor the entire eukaryotic target 
labeling process, a set of poly-A RNA controls is supplied in the GeneChip™ Eukaryotic Poly-A RNA 
Control Kit. 

Each eukaryotic GeneChip™ probe array contains probe sets for several B. subtilis genes that are absent in 
eukaryotic samples (lys, phe, thr, and dap). These poly-A RNA controls are in vitro synthesized, and the 
polyadenylated transcripts for the B. subtilis genes are pre-mixed at staggered dilutions. The concentrated 
Poly-A Control Stock can be diluted with the Poly-A Control Dil Buffer and spiked directly into RNA 
samples to achieve the final dilutions (referred to as a ratio of copy number) summarized in Table 2.2. 

Table 2.2 
Final Dilutions of Poly-A RNA Controls in Samples 

Poly-A RNA Spike Final Dilution 
(estimated ratio of copy number) 

lys 1:100,000 

phe 1:50,000 

thr 1:25,000 

dap 1:6,667 

1 Users who do not purchase this Kit may be required to obtain a license under U.S. Patent Nos. 5,716,785, 
5,891,636, 6,291,170, and 5,545,522 or to purchase another licensed kit. 
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The controls are then amplified and labeled together with the samples. Examining the hybridization 
intensities of these controls on GeneChip™ arrays helps to monitor the labeling process independently 
from the quality of the starting RNA samples. Anticipated relative signal strength follows the order of lys < 
phe < thr< dap. 

The Poly-A RNA Control Stock and Poly-A Control Dil Buffer are provided with the kit to prepare the 
appropriate serial dilutions based on Table 2.3. This is a guideline when 1, 5, or 10 µg of total RNA or 0.2 µg 
of mRNA is used as starting material. For starting sample amounts other than those listed here, calculations 
are needed in order to perform the appropriate dilutions to arrive at the same proportionate final dilution 
of the spike-in controls in the samples. 

 

Use non-stick RNase-free microfuge tubes to prepare all of the 
dilutions. 

Table 2.3 
Serial Dilutions of Poly-A RNA Control Stock 

Starting Amount  Serial Dilutions Spike-in Volume 

Total RNA mRNA First Second Third  

1 µg  1:20 1:50 1:50 2 µL 

5 µg  1:20 1:50 1:10 2 µL 

10 µg 0.2 µg 1:20 1:50 1:5 2 µL 

 

 

Avoid pipetting solutions less than 2 µL in volume to maintain precision and 
consistency when preparing the dilutions. 

For example, to prepare the poly-A RNA dilutions for 5 µg of total RNA: 
1. Add 2 µL of the Poly-A Control Stock to 38 µL of Poly-A Control Dil Buffer for the First Dilution 

(1:20). 

2. Mix thoroughly and spin down to collect the liquid at the bottom of the tube. 

3. Add 2 µL of the First Dilution to 98 µL of Poly-A Control Dil Buffer to prepare the Second Dilution 
(1:50). 

4. Mix thoroughly and spin down to collect the liquid at the bottom of the tube. 

5. Add 2 µL of the Second Dilution to 18 µL of Poly-A Control Dil Buffer to prepare the Third Dilution 
(1:10). 

6. Mix thoroughly and spin down to collect the liquid at the bottom of the tube. 

7. Add 2 µL of this Third Dilution to 5 µg of sample total RNA. 

 

The First Dilution of the poly-A RNA controls can be stored up to six weeks in a 
non-frost-free freezer at –20°C and frozen-thawed up to eight times. 
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Step 2: First-Strand cDNA Synthesis 
One-Cycle cDNA Synthesis Kit is used for this step. 

 

1. Briefly spin down all tubes in the Kit before using the reagents. 

2. Perform all of the incubations in thermal cyclers. The following program 
can be used as a reference to perform the first-strand cDNA synthesis 
reaction in a thermal cycler; the 4°C holds are for reagent addition steps: 

70°C 10 minutes 

4°C hold 

42°C 2 minutes 

42°C 1 hour 

4°C hold 

1. Mix RNA sample, diluted poly-A RNA controls, and T7-Oligo(dT) Primer. 

Table 2.4 RNA/T7-Oligo(dT) Primer Mix Preparation for 1 to 8 µg of total RNA, or 0.2 to 1 µg of mRNA 

Component Volume 

Sample RNA variable 

Diluted poly-A RNA controls 2 µL 

T7-Oligo(dT) Primer, 50 µM 2 µL 

RNase-free Water variable 

Total Volume 12 µL 

Table 2.5 RNA/T7-Oligo(dT) Primer Mix Preparation for 8.1 to 15 µg of total RNA, or > 1 µg of mRNA 

Component Volume 

Sample RNA variable 

Diluted poly-A RNA controls 2 µL 

T7-Oligo(dT) Primer, 50 µM 2 µL 

RNase-free Water variable 

Total Volume 11 µL 

a. Place total RNA (1 µg to 15 µg) or mRNA sample (0.2 µg to 2 µg) in a 0.2 mL PCR tube. 

b. Add 2 µL of the appropriately diluted poly-A RNA controls (See Step 1: Preparation of Poly-A RNA 
Controls for One-Cycle cDNA Synthesis (Spike-in Controls)). 

c. Add 2 µL of 50 µM T7-Oligo(dT) Primer. 

d. Add RNase-free Water to a final volume of 11 or 12 µL (see Table 2.4 and Table 2.5). 

e. Gently flick the tube a few times to mix, and then centrifuge briefly (~5 seconds) to collect the 
reaction at the bottom of the tube. 

f. Incubate the reaction for 10 minutes at 70°C. 

g. Cool the sample at 4°C for at least 2 minutes. 

h. Centrifuge the tube briefly (~5 seconds) to collect the sample at the bottom of the tube. 
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2. In a separate tube, assemble the First-Strand Master Mix. 

a. Prepare sufficient First-Strand Master Mix for all of the RNA samples. When there are more than 
2 samples, it is prudent to include additional material to compensate for potential pipetting 
inaccuracy or solution lost during the process. The following recipe, in Table 2.6, is for a single 
reaction. 

Table 2.6 Preparation of First-Strand Master Mix 

Component Volume 

5X 1st Strand Reaction Mix 4 µL 

DTT, 0.1M 2 µL 

dNTP, 10 mM 1 µL 

Total Volume 7 µL 

b. Mix well by flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the master mix 
at the bottom of the tube. 

3. Transfer 7 µL of First-Strand Master Mix to each RNA/T7-Oligo(dT) Primer mix for a final volume 
of 18 or 19 µL. Mix thoroughly by flicking the tube a few times. Centrifuge briefly (~5 seconds) to 
collect the reaction at the bottom of the tube, and immediately place the tubes at 42°C. 

4. Incubate for 2 minutes at 42°C. 

5. Add the appropriate amount of SuperScript II to each RNA sample for a final volume of 20 µL. 

• For 1 to 8 µg of total RNA: 1 µL SuperScript II 

• For 8.1 to 15 µg of total RNA: 2 µL SuperScript II 

• For every µg of mRNA add 1 µL SuperScript II. 

• For mRNA quantity less than 1 µg, use 1 µL SuperScript II. 

Mix thoroughly by flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
reaction at the bottom of the tube, and immediately place the tubes at 42°C. 

6. Incubate for 1 hour at 42°C; then cool the sample for at least 2 minutes at 4°C. 

 

Cooling the samples at 4°C is required before proceeding to the next 
step. Adding the Second-Strand Master Mix directly to solutions that are 
at 42°C will compromise enzyme activity. 

After incubation at 4°C, centrifuge the tube briefly (~5 seconds) to collect the reaction at the bottom of the 
tube and immediately proceed to Step 3: Second-Strand cDNA Synthesis. 
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Step 3: Second-Strand cDNA Synthesis 
One-Cycle cDNA Synthesis Kit is used for this step. 

 

The following program can be used as a reference to perform the second-strand 
cDNA synthesis reaction in a thermal cycler. 

16°C 2 hours 

4°C hold 

16°C 5 minutes 

4°C hold 

1. In a separate tube, assemble Second-Strand Master Mix. 

 

It is recommended to prepare Second-Strand Master Mix immediately before use. 

a. Prepare sufficient Second-Strand Master Mix for all of the samples. When there are more than 2 
samples, it is prudent to include additional material to compensate for potential pipetting 
inaccuracy or solution lost during the process. The following recipe, in Table 2.7, is for a single 
reaction. 

Table 2.7 Preparation of Second-Strand Master Mix 

Component Volume 

RNase-free Water 91 µL 

5X 2nd Strand Reaction Mix 30 µL 

dNTP, 10 mM 3 µL 

E. coli DNA ligase 1 µL 

E. coli DNA Polymerase I 4 µL 

RNase H 1 µL 

Total Volume 130 µL 

b. Mix well by gently flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
solution at the bottom of the tube. 

2. Add 130 µL of Second-Strand Master Mix to each first-strand synthesis sample from Step 2: First-
Strand cDNA Synthesis for a total volume of 150 µL.  

Gently flick the tube a few times to mix, and then centrifuge briefly (~5 seconds) to collect the 
reaction at the bottom of the tube. 

3. Incubate for 2 hours at 16°C. 

4. Add 2 µL of T4 DNA Polymerase to each sample and incubate for 5 minutes at 16°C. 

5. After incubation with T4 DNA Polymerase add 10 µL of EDTA, 0.5M and proceed to Cleanup of 
Double-Stranded cDNA for Both the One-Cycle and Two-Cycle Target Labeling Assays. 

Do not leave the reactions at 4°C for long periods of time. 
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Two-Cycle cDNA Synthesis1 
Step 1: Preparation of Poly-A RNA Controls for Two-Cycle cDNA 
Synthesis (Sike-In Controls) 

Eukaryotic Poly-A RNA Control Kit is used for this step. 
Designed specifically to provide exogenous positive controls to monitor the entire eukaryotic target 
labeling process, a set of poly-A RNA controls are supplied in the GeneChip™ Eukaryotic Poly-A RNA 
Control Kit. 

Each eukaryotic GeneChip™ probe array contains probe sets for several B.subtilis genes that are absent in 
eukaryotic samples (lys, phe, thr, and dap). These poly-A RNA controls are in vitro synthesized, and the 
polyadenylated transcripts for these B. subtilis genes are pre-mixed at staggered dilutions. The concentrated 
Poly-A Control Stock can be diluted with the Poly-A Control Dil Buffer and spiked directly into the RNA 
samples to achieve the final dilutions (referred to as a ratio of copy number) summarized below: 

Table 2.8 Final Dilutions of Poly-A RNA Controls in Samples 

Poly-A RNA Spike Final Dilution 
(estimated ratio of copy number) 

lys 1:100,000 

phe 1:50,000 

thr 1:25,000 

dap 1:6,667 

The controls are then amplified and labeled together with the samples. Examining the hybridization 
intensities of these controls on GeneChip™ arrays helps to monitor the labeling process independently 
from the quality of the starting RNA samples. Anticipated relative signal strength follows the order of lys < 
phe < thr< dap. 

The Poly-A RNA Control Stock and Poly-A Control Dil Buffer are provided with the kit to prepare the 
appropriate serial dilutions based on Table 2.9. This is a guideline when 10, 50, or 100 ng of total RNA is 
used as starting material. For other intermediate starting sample amounts, calculations are needed in order 
to perform the appropriate dilutions to arrive at the same proportionate final concentration of the spike-in 
controls in the samples. 

1 Users who do not purchase this Kit may be required to obtain a license under U.S. Patent Nos. 5,716,785, 5,891,636, 
6,291,170, and 5,545,522 or to purchase another licensed kit. 

 

• The dilution scheme outlined below is different from the previous protocol developed for 
the Small Sample Target Labeling vII. Closely adhere to the recommendation below to 
obtain the desired final concentrations of the controls. 

• Use non-stick RNase-free microfuge tubes to prepare the dilutions. 
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Table 2.9 Serial Dilutions of Poly-A RNA Control Stock 

Starting 
Amount of 
Total RNA 

Serial Dilutions Volume to Add 
into 50 µM T7- 

Oligo(dT) Primer First Second Third Fourth 

10 ng 1:20 1:50 1:50 1:10 2 µL 

50 ng 1:20 1:50 1:50 1:2 2 µL 

100 ng 1:20 1:50 1:50  2 µL 

 

 

Avoid pipetting solutions less than 2 µL in volume to maintain precision and consistency 
when preparing the dilutions. 

For example, to prepare the poly-A RNA dilutions for 10 ng of total RNA: 
1. Add 2 µL of the Poly-A Control Stock to 38 µL of Poly-A Control Dil Buffer to prepare the First 

Dilution (1:20). 

2. Mix thoroughly and spin down to collect the liquid at the bottom of the tube. 

3. Add 2 µL of the First Dilution to 98 µL of Poly-A Control Dil Buffer to prepare the Second Dilution 
(1:50). 

4. Mix thoroughly and spin down to collect the liquid at the bottom of the tube. 

5. Add 2 µL of the Second Dilution to 98 µL of Poly-A Control Dil Buffer to prepare the Third Dilution 
(1:50). 

6. Mix thoroughly and spin down to collect the liquid at the bottom of the tube. 

7. Add 2 µL of the Third Dilution to 18 µL of Poly-A Control Dil Buffer to prepare the Fourth Dilution 
(1:10). 

8. Use the Fourth Dilution to prepare the solution described next. 

 

The first dilution of the poly-A RNA controls (1:20) can be stored in a non-frost-
free freezer at –20°C up to six weeks and frozen-thawed up to eight times. 
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Preparation of T7-Oligo(dT) Primer/Poly-A Controls Mix 
Prepare a fresh dilution of the T7-Oligo(dT) Primer from 50 µM to 5 µM. The diluted poly-A RNA controls 
should be added to the concentrated T7-Oligo(dT) Primer as follows, using a non-stick RNase-free 
microfuge tube. The following recipe is sufficient for 10 samples. 

Table 2.10 
Preparation of T7-Oligo(dT) Primer/Poly-A Controls Mix 

Component Volume 

T7-Oligo(dT) Primer, 50 µM 2 µL 

Diluted Poly-A RNA controls (Table 2.9) 2 µL 

RNase-free Water 16 µL 

Total Volume 20 µL 

Step 2: First-Cycle, First-Strand cDNA Synthrsis 
Two-Cycle cDNA Synthesis Kit is used for this step. 

 

1. Briefly spin down all tubes in the Kit before using the reagents. 

2. Perform all of the incubations in thermal cyclers. The following program 
can be used as a reference to perform the First-Cycle, First-Strand cDNA 
synthesis reaction in a thermal cycler; the 4°C holds are for reagent 
addition steps 

70°C 6 minutes 

4°C hold 

42°C 1 hour 

70°C 10 minutes 

4°C hold 

1. Mix total RNA sample and the T7-Oligo(dT) Primer/Poly-A Controls Mix. 

Table 2.11 
Preparation of Total RNA Sample/T7-Oligo(dT) Primer/Poly-A Controls Mix 

Component Volume 

Total RNA sample variable (10 – 100 ng) 

T7-Oligo(dT) Primer/Poly-A Controls Mix 2 µL 

RNase-free Water variable 

Total Volume 5 µL 

a. Place total RNA sample (10 to 100 ng) in a 0.2 mL PCR tube. 

b. Add 2 µL of the T7-Oligo(dT) Primer/Poly-A Controls Mix (See Step 1: Preparation of Poly-A RNA 
Controls for Two-Cycle cDNA Synthesis (Spike-in Controls)). 

c. Add RNase-free Water to a final volume of 5 µL. 

d. Gently flick the tube a few times to mix, then centrifuge the tubes briefly (~5 seconds) to collect 
the solution at the bottom of the tube. 

e. Incubate for 6 minutes at 70°C. 
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f. Cool the sample at 4°C for at least 2 minutes. Centrifuge briefly (~5 seconds) to collect the sample 
at the bottom of the tube. 

2. In a separate tube, assemble the First-Cycle, First-Strand Master Mix. 

a. Prepare sufficient First-Cycle, First-Strand Master Mix for all of the total RNA samples. When 
there are more than 2 samples, it is prudent to include additional material to compensate for 
potential pipetting inaccuracy or solution lost during the process. The following recipe, in Table 
2.12, is for a single reaction. 

Table 2.12 
Preparation of First-Cycle, First-Strand Master Mix 

Component Volume 

5X 1st Strand Reaction Mix 2.0 µL 

DTT, 0.1M 1.0 µL 

RNase Inhibitor 0.5 µL 

dNTP, 10 mM 0.5 µL 

SuperScript II 1.0 µL 

Total Volume 5.0 µL 

b. Mix well by gently flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
solution at the bottom of the tube. 

3. Transfer 5 µL of First-Cycle, First-Strand Master Mix to each total RNA sample/T7-Oligo(dT) 
Primer/Poly-A Controls Mix (as in Table 2.11) from the previous step for a final volume of 10 µL.  

Mix thoroughly by gently flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
reaction at the bottom of the tube, and immediately place the tubes at 42°C. 

4. Incubate for 1 hour at 42°C. 

5. Heat the sample at 70°C for 10 minutes to inactivate the RT enzyme, then cool the sample for at least 
2 minutes at 4°C. After the 2 minute incubation at 4°C, centrifuge the tube briefly (~5 seconds) to 
collect the reaction at the bottom of the tube and immediately proceed to Step 3: First-Cycle, Second-
Strand cDNA Synthesis. 

 

Cooling the sample at 4°C is required before proceeding to the next step. 
Adding the First-Cycle, Second-Strand Master Mix directly to solutions that 
are at 70°C will compromise enzyme activity. 
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Step 3: First-Cycle, Second-Strand cDNA Synthesis 
Two-Cycle cDNA Synthesis Kit is used for this step. 

 

The following program can be used as a reference to perform the First-cycle, 
Second-strand cDNA synthesis reaction in a thermal cycler. For the 16°C 
incubation, turn the heated lid function off. If the heated lid function cannot be 
turned off, leave the lid open. Use the heated lid for the 75°C incubation. 

16°C 2 hours 

75°C 10 minutes 

4°C hold 

1. In a separate tube, assemble the First-Cycle, Second-Strand Master Mix. 

 

It is recommended to prepare this First-Cycle, Second-Strand Master Mix 
immediately before use. Prepare this First-Cycle, Second-Strand Master Mix 
for at least 4 reactions at one time for easier and more accurate pipetting. 

a. Prepare sufficient First-Cycle, Second-Strand Master Mix for all samples. When there are more 
than 2 samples, it is prudent to include additional material to compensate for potential pipetting 
inaccuracy or solution lost during the process. The following recipe, in Table 2.13, is for a single 
reaction. 

Table 2.13 Preparation of First-Cycle, Second-Strand Master Mix 

Component Volume 

RNase-free Water 4.8 µL 

Freshly diluted MgCl2, 17.5 mM* 4.0 µL 

dNTP, 10 mM 0.4 µL 

E. coli DNA Polymerase I 0.6 µL 

RNase H 0.2 µL 

Total Volume 10.0 µL 

* Make a fresh dilution of the MgCl2 each time. Mix 2 µL of MgCl2, 1M with 112 µL of RNase-free Water. 

b. Mix well by gently flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
solution at the bottom of the tube. 

2. Add 10 µL of the First-Cycle, Second-Strand Master Mix to each sample from Step 2: First-Cycle, 
First-Strand cDNA Synthesis reaction for a total volume of 20 µL.  

Gently flick the tube a few times to mix, and then centrifuge briefly (~5 seconds) to collect the 
reaction at the bottom of the tube. 

3. Incubate for 2 hours at 16°C, then 10 minutes at 75°C and cool the sample at least 2 minutes at 4°C. 
Turn the heated lid function off only for the 16°C incubation.  

After the 2 minute incubation at 4°C, centrifuge the tube briefly (~5 seconds) to collect the reaction at 
the bottom of the tube. Proceed to Step 4: First-Cycle, IVT Amplification of cRNA. 

 

No cDNA cleanup is required at this step. 
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Step 4: First-Cycle, IVT Amplification of cRNA 
MEGAscript™ T7 Kit (purchased separately from Ambion, Inc.) is used for this step. 

 

The following program can be used as a reference to perform the First-cycle, 
IVT Amplification of cRNA reaction in a thermal cycler. 

37°C 16 hours 

4°C hold 

1. In a separate tube, assemble the First-Cycle, IVT Master Mix at room temperature. 

a. Prepare sufficient First-Cycle, IVT Master Mix for all of the samples. When there are more than 2 
samples, it is prudent to include additional material to compensate for potential pipetting 
inaccuracy or solution lost during the process. The following recipe, in Table 2.14, is for a single 
reaction. 

Table 2.14 
Preparation of First-Cycle, IVT Master Mix 

Component Volume 

10X Reaction Buffer 5 µL 

ATP Solution 5 µL 

CTP Solution 5 µL 

UTP Solution 5 µL 

GTP Solution 5 µL 

Enzyme Mix 5 µL 

Total Volume 30 µL 

b. Mix well by gently flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
solution at the bottom of the tube. 

2. Transfer 30 µL of First-Cycle, IVT Master Mix to each cDNA sample. 

At room temperature, add 30 µL of the First-Cycle, IVT Master Mix to each 20 µL of cDNA sample 
from Step 3: First-Cycle, Second-Strand cDNA Synthesis for a final volume of 50 µL. Gently flick the 
tube a few times to mix, then centrifuge briefly (~5 seconds) to collect the reaction at the bottom of 
the tube. 

3. Incubate for 16 hours at 37°C. 

After the 16 hour incubation at 37°C, centrifuge the tube briefly (~5 seconds) to collect the reaction at 
the bottom of the tube. The sample is now ready to be purified in Step 5: First-Cycle, Cleanup of cRNA. 
Alternatively, samples may be stored at –20°C for later use. 
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Step 5: First-Cycle, Cleanup of cRNA 
IVT cRNA Cleanup Kit is used for this step. 

Reagents to be Supplied by User 
• Ethanol, 96–100% (v/v) 

• Ethanol, 80% (v/v) 

All other components needed for cleanup of cRNA are supplied with the GeneChip™ IVT cRNA Cleanup 
Kit. 

 

BEFORE STARTING note the following: 

• IVT cRNA Wash Buffer is supplied as a concentrate. Before using for the first 
time, add 20 mL of ethanol (96–100%), as indicated on the bottle, to obtain a 
working solution, and checkmark the box on the left-hand side of the bottle 
label to avoid confusion. 

• IVT cRNA Binding Buffer may form a precipitate upon storage. If necessary, 
redissolve by warming in a water bath at 30°C, and then place the buffer at 
room temperature. 

• All steps of the protocol should be performed at room temperature. During 
the procedure, work without interruption. 

1. Add 50 µL of RNase-free Water to the IVT reaction and mix by vortexing for 3 seconds. 

2. Add 350 µL IVT cRNA Binding Buffer to the sample and mix by vortexing for 3 seconds. 

3. Add 250 µL ethanol (96-100%) to the lysate, and mix well by pipetting. Do not centrifuge. 

4. Apply sample (700 µL) to the IVT cRNA Cleanup Spin Column sitting in a 2 mL Collection Tube. 
Centrifuge for 15 seconds at ≥8,000 x g (≥10,000 rpm). Discard flow-through and Collection Tube. 

5. Transfer the spin column into a new 2 mL Collection Tube (supplied). Pipet 500 µL IVT cRNA 
Wash Buffer onto the spin column. Centrifuge for 15 seconds at ≥8,000 x g (≥10,000 rpm) to wash. 
Discard flow-through. 

 

IVT cRNA Wash Buffer is supplied as a concentrate. Ensure that ethanol is 
added to the IVT cRNA Wash Buffer before use (see IMPORTANT note above 
before starting). 

6. Pipet 500 µL 80% (v/v) ethanol onto the spin column and centrifuge for 15 seconds at ≥ 8,000 x g (≥ 
10,000 rpm). Discard flow-through. 

7. Open the cap of the spin column and centrifuge for 5 minutes at maximum speed (≤ 25,000 x g). 
Discard flow-through and Collection Tube. 

Place columns into the centrifuge using every second bucket. Position caps over the adjoining bucket 
so that they are oriented in the opposite direction to the rotation (i.e., if the microcentrifuge rotates in 
a clockwise direction, orient the caps in a counterclockwise direction). This avoids damage of the 
caps. 

 

Label the collection tubes with the sample name. During centrifugation some column 
caps may break, resulting in loss of sample information. 

Centrifugation with open caps allows complete drying of the membrane. 
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8. Transfer spin column into a new 1.5 mL Collection Tube (supplied), and pipet 13 µL of RNase-free 
Water directly onto the spin column membrane. Ensure that the water is dispensed directly onto the 
membrane. Centrifuge 1 minute at maximum speed (≤25,000 x g) to elute. The average volume of 
eluate is 11 µL from 13 µL RNase-free Water. 

9. To determine cRNA yield for samples starting with 50 ng or higher, remove 2 µL of the cRNA, and 
add 78 µL of water to measure the absorbance at 260 nm. Use 600 ng of cRNA in the following Step 6: 
Second-Cycle, First-Strand cDNA Synthesis. 

For starting material less than 50 ng, or if the yield is less than 600 ng, use the entire eluate for the 
Second-Cycle, First-Strand cDNA Synthesis Reaction. 

Samples can be stored at –20°C for later use, or proceed to Step 6: Second-Cycle, First-Strand cDNA 
Synthesis described next. 

Step 6: Second-Cycle, First-Strand cDNA Synthesis 
Two-Cycle cDNA Synthesis Kit is used for this step. 

 

The following program can be used as a reference to perform the Second-Cycle, 
First-Strand cDNA synthesis reaction in a thermal cycler; the 4°C holds are for 
reagent addition steps: 

70°C  10 minutes 

4°C  hold 

42°C  1 hour 

4°C  hold 

37°C  20 minutes 

95°C  5 minutes 

4°C  hold 

1. Mix cRNA and diluted random primers. 

a. Make a fresh dilution of the Random Primers (final concentration 0.2 µg/µL). Mix 2 µL of 
Random Primers, 3 µg/µL, with 28 µL RNase-free Water. 

b. Add 2 µL of diluted random primers to purified cRNA from Step 5: First-Cycle, Cleanup of cRNA, substep 
9, and add RNase-free Water for a final volume of 11 µL. 

c. Incubate for 10 minutes at 70°C. 
d. Cool the sample at 4°C for at least 2 minutes. Centrifuge briefly (~5 seconds) to collect the sample at the 

bottom of the tube. 

2. In a separate tube, assemble the Second-Cycle, First-Strand Master Mix. 

a. Prepare sufficient Second-Cycle, First-Strand Master Mix for all of the samples. When there are 
more than two samples, it is prudent to include additional material to compensate for potential 
pipetting inaccuracy or solution lost during the process. The following recipe, in Table 2.15, is for 
a single reaction. 
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Table 2.15 Preparation of Second-Cycle, First-Strand Master Mix 

Component Volume 

5X 1st Strand Reaction Mix 4 µL 

DTT, 0.1M 2 µL 

RNase Inhibitor 1 µL 

dNTP, 10 mM 1 µL 

SuperScript II 1 µL 

Total Volume 9 µL 

b. Mix well by gently flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
solution at the bottom of the tube. 

3. Transfer 9 µL of Second-Cycle, First-Strand Master Mix to each cRNA/random primer sample from 
Step 6: Second-Cycle, First-Strand cDNA Synthesis, substep 1, for a final volume of 20 µL. 

Mix thoroughly by gently flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
reaction at the bottom of the tube and place the tubes at 42°C immediately. 

4. Incubate for 1 hour at 42°C, then cool the sample for at least 2 minutes at 4°C. 

After the incubation at 4°C, centrifuge briefly (~5 seconds) to collect the reaction at the bottom of the tube. 

5. Add 1 µL of RNase H to each sample for a final volume of 21 µL. 

Mix thoroughly by gently flicking the tube a few times. 

Centrifuge briefly (~5 seconds) to collect the reaction at the bottom of the tube and incubate for 20 
minutes at 37°C. 

6. Heat the sample at 95°C for 5 minutes. Cool the sample for at least 2 minutes at 4°C; then, proceed 
directly to Step 7: Second-Cycle, Second-Strand cDNA Synthesis. 

Step 7: Second-Cycle, Second-Strand cDNA Synthesis 
Two-Cycle cDNA Synthesis Kit is used for this step. 

 

The following program can be used as a reference to perform the Second-
Cycle, Second-Strand cDNA Synthesis reaction in a thermal cycler. For the 
16°C incubations turn the heated lid function off. If the heated lid function 
cannot be turned off, leave the lid open. The 4°C holds are for reagent 
addition steps: 

70°C 6 minutes 

4°C hold 

16°C 2 hours 

4°C hold 

16°C 10 minutes 

4°C hold 
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1. Add 4 µL of diluted T7-Oligo(dT) Primer to each sample. 

a. Make a fresh dilution of the T7-Oligo(dT) Primer (final concentration 5 µM). Mix 2 µL of T7-
Oligo(dT) Primer, 50 µM, with 18 µL of RNase-free Water. 

b. Add 4 µL of diluted T7-Oligo(dT) Primer to the sample from Step 6: Second-Cycle, First-Strand cDNA 
Synthesis, substep 6, for a final volume of 25 µL. 

c. Gently flick the tube a few times to mix, and then centrifuge briefly (~5 seconds) to collect the reaction at 
the bottom of the tube. 

d. Incubate for 6 minutes at 70°C. 
e. Cool the sample at 4°C for at least 2 minutes. Centrifuge briefly (~5 seconds) to collect sample at the 

bottom of the tube. 

 

Cooling the samples at 4°C is required before proceeding to the next step. 
Adding the Second-Strand Master Mix directly to solutions that are at 70°C 
will compromise enzyme activity. 

 

It is recommended to prepare the Second-Cycle, Second-Strand Master Mix 
immediately before use. 

2. In a separate tube, assemble the Second-Cycle, Second-Strand Master Mix. 

a. Prepare sufficient Second-Cycle, Second-Strand Master Mix for all of the samples. When there are 
more than two samples, it is prudent to include additional material to compensate for potential 
pipetting inaccuracy or solution lost during the process. The following recipe, in Table 2.16, is for 
a single reaction. 

Table 2.16 Preparation of Second-Cycle, Second-Strand Master Mix 

Component Volume 

RNase-free Water 88 µL 

5X 2nd Strand Reaction Mix 30 µL 

dNTP, 10 mM 3 µL 

E. coli DNA Polymerase I 4 µL 

Total Volume 125 µL 

b. Mix well by gently flicking the tube a few times. Centrifuge briefly (~5 seconds) to collect the 
master mix at the bottom of the tube. 

3. Add 125 µL of the Second-Cycle, Second-Strand Master Mix to each sample from Step 7: Second-
Cycle, Second-Strand cDNA Synthesis, substep 1, for a total volume of 150 µL. 

Gently flick the tube a few times to mix, then centrifuge briefly (~5 seconds) to collect the reaction at 
the bottom of tube. 

4. Incubate for 2 hours at 16°C. 

5. Add 2 µL of T4 DNA Polymerase to the samples for a final volume of 152 µL. Gently flick the tube a 
few times to mix, and then centrifuge briefly (~5 seconds) to collect the reaction at the bottom of the 
tube. 

6. Incubate for 10 minutes at 16°C, then cool the sample at 4°C for at least 2 minutes. Centrifuge briefly 
(~5 seconds) to collect sample at the bottom of the tube. 

After the incubation at 4°C, centrifuge the tube briefly (~5 seconds) to collect the reaction at the bottom of the 
tube. Proceed to Cleanup of Double-Stranded cDNA for Both the One-Cycle and Two-Cycle Target Labeling 
Assays. Alternatively, immediately freeze the sample at –20°C for later use. Do not leave the reaction at 4°C 
for long periods of time. 



 

32 GeneChip™ Expression Analysis Technical Manual User Guide 

Cleanup of Double-Stranded cDNA for Both the One-Cycle and 
Two-Cycle Target Labeling Assays 
Sample Cleanup Module is used for cleaning up the double-stranded cDNA. 

Reagents to be Supplied by User 
• Ethanol, 96–100% (v/v) 

All other components needed for cleanup of double-stranded cDNA are supplied with the GeneChip™ 
Sample Cleanup Module. 

 

BEFORE STARTING, note the following: 

• cDNA Wash Buffer is supplied as a concentrate. Before using for the 
first time, add 24 mL of ethanol (96-100%), as indicated on the bottle, 
to obtain a working solution, and checkmark the box on the left-hand 
side of the bottle label to avoid confusion. 

• All steps of the protocol should be performed at room temperature. 
During the procedure, work without interruption. 

• If cDNA synthesis was performed in a reaction tube smaller than mL, 
transfer the reaction mixture into a 1.5 or 2 mL microfuge tube (not 
supplied) prior to addition of cDNA Binding Buffer. 

1. Add 600 µL of cDNA Binding Buffer to the double-stranded cDNA synthesis preparation. Mix by 
vortexing for 3 seconds. 

2. Check that the color of the mixture is yellow (similar to cDNA Binding Buffer without the cDNA 
synthesis reaction). 

 
If the color of the mixture is orange or violet, add 10 µL of 3M sodium acetate, 
pH 5.0, and mix. The color of the mixture will turn to yellow. 

3. Apply 500 µL of the sample to the cDNA Cleanup Spin Column sitting in a 2 mL Collection Tube 
(supplied), and centrifuge for 1 minute at ≥8,000 x g (≥10,000 rpm). Discard flow-through. 

4. Reload the spin column with the remaining mixture and centrifuge as above. Discard flow-through 
and Collection Tube. 

5. Transfer spin column into a new 2 mL Collection Tube  (supplied). Pipet 750 µL of the cDNA Wash 
Buffer onto the spin column. Centrifuge for 1 minute at ≥8,000 x g (≥10,000 rpm). Discard flow-
through. 

 
cDNA Wash Buffer is supplied as a concentrate. Ensure that ethanol is added to 
the cDNA Wash Buffer before use (see IMPORTANT note above before starting). 

6. Open the cap of the spin column and centrifuge for 5 minutes at maximum speed (≤ 25,000 x g). 
Discard flow-through and Collection Tube. 

 

Label the collection tubes with the sample name. During centrifugation some column 
caps may break, resulting in loss of sample information. 

Place columns into the centrifuge using every second bucket. Position caps over the adjoining bucket 
so that they are oriented in the opposite direction to the rotation (i.e., if the microcentrifuge rotates in 
a clockwise direction, orient the caps in a counterclockwise direction). This avoids damage of the 
caps. 
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Centrifugation with open caps allows complete drying of the membrane. 

7. Transfer spin column into a 1.5 mL Collection Tube, and pipet 14 µL of cDNA Elution Buffer 
directly onto the spin column membrane. Incubate for 1 minute at room temperature and centrifuge 
1 minute at maximum speed (≤25,000 x g) to elute. 

Ensure that the cDNA Elution Buffer is dispensed directly onto the membrane. The average volume of eluate is 
12 µL recovered from the 14 µL of Elution Buffer. 

 

We do not recommend RNase treatment of the cDNA prior to the in vitro 
transcription and labeling reaction; the carry-over ribosomal RNA does not 
seem to inhibit the reaction. 

We do not recommend gel analysis or spectrophotometric quantitation for 
cDNA prepared from total RNA. This is due to the presence of other nucleic 
acid species in the sample that can interfere with the results. 

8. After cleanup, proceed to Synthesis of Biotin-Labeled cRNA for Both the One-Cycle and Two-Cycle 
Target Labeling Assays. 

Synthesis of Biotin-Labeled cRNA for Both the One-Cycle and 
Two-Cycle Target Labeling Assays 
GeneChip™ IVT Labeling Kit is used for this step. 

 

This kit is only used for the IVT labeling step for generating biotin-labeled 
cRNA. For the IVT amplification step using unlabeled ribonucleotides in the 
First Cycle of the Two-Cycle cDNA Synthesis Procedure, a separate kit is 
recommended (MEGAscriptTM T7 Kit, Ambion, Inc.). Use only nuclease-free 
water, buffers, and pipette tips. 

 

 
Store all reagents in a –20°C freezer that is not self-defrosting. Prior to use, 
centrifuge all reagents briefly to ensure that the solution is collected at the 
bottom of the tube. The Target Hybridizations and Array Washing protocols 
have been optimized specifically for this IVT Labeling Protocol. Closely follow 
the recommendations described below for maximum array performance. 

1. Use the following table to determine the amount of cDNA used for each IVT reaction following the 
cDNA cleanup step. 

Table 2.17 IVT Reaction Set Up 

Starting Material Volume of cDNA to use in IVT 

Total RNA 

10 to 100 ng all (~12 µL) 

1.0 to 8.0 µg all (~12 µL) 

8.1 to 15 µg 6 µL 

mRNA 

0.2 to 0.5 µg all (~12 µL) 

0.6 to 1.0 µg 9 µL 

1 to 2.0 µg 6 µL 
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2. Transfer the needed amount of template cDNA to RNase-free microfuge tubes and add the following 
reaction components in the order indicated in the table below. If more than one IVT reaction is to be 
performed, a master mix can be prepared by multiplying the reagent volumes by the number of 
reactions. Do not assemble the reaction on ice, since spermidine in the 10X IVT Labeling Buffer can 
lead to precipitation of the template cDNA. 

Table 2.18 

Component Volume 

Template cDNA* variable (see Table 2.17) 

RNase-free Water Variable 
(to give a final reaction volume of 40 µL) 

10X IVT Labeling Buffer 4 µL 

IVT Labeling NTP Mix 12 µL 

IVT Labeling Enzyme Mix 4 µL 

Total Volume 40 µL 

*0.5 to 1 µg of the 3’-Labeling Control can be used in place of the template cDNA sample in this reaction as a positive control for the IVT 
components in the kit. 

3. Carefully mix the reagents and collect the mixture at the bottom of the tube by brief (~5 seconds) 
microcentrifugation. 

4. Incubate at 37°C for 16 hours. To prevent condensation that may result from water bath-style 
incubators, incubations are best performed in oven incubators for even temperature distribution, or 
in a thermal cycler. 

 

Overnight IVT reaction time has been shown to maximize the labeled cRNA 
yield with high-quality array results. Alternatively, if a shorter incubation 
time (4 hours) is desired, 1 µL (200 units) of cloned T7 RNA polymerase (can 
be purchased directly from Thermo Fisher Scientific, P/N 2085) can be added 
to each reaction and has been shown to produce adequate labeled cRNA yield 
within 4 hours. The two different incubation protocols generate comparable 
array results, and users are encouraged to choose the procedure that best 
fits their experimental schedule and process flow. 

5. Store labeled cRNA at –20°C, or –70°C if not purifying immediately. Alternatively, proceed to 
Cleanup and Quantification of Biotin-Labeled cRNA. 
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Cleanup and Quantification of Biotin-Labeled cRNA 
Sample Cleanup Module is used for cleaning up the biotin-labeled cRNA. 

Reagents to be Supplied by User 
• Ethanol, 96–100% (v/v) 

• Ethanol, 80% (v/v) 

All other components needed for cleanup of biotin-labeled cRNA are supplied with the GeneChip™ 
Sample Cleanup Module. 

Step 1: Cleanup of Biotin-Labeled cRNA 

 

BEFORE STARTING, note the following: 

• It is essential to remove unincorporated NTPs, so that the 
concentration and purity of cRNA can be accurately determined by 260 
nm absorbance. 

• DO NOT extract biotin-labeled RNA with phenol-chloroform. The biotin 
will cause some of the RNA to partition into the organic phase. This will 
result in low yields. 

• Save an aliquot of the unpurified IVT product for analysis by gel 
electrophoresis. 

• IVT cRNA Wash Buffer is supplied as a concentrate. Before using for 
the first time, add 20 mL of ethanol (96–100%), as indicated on the 
bottle, to obtain a working solution, and checkmark the box on the left-
hand side of the bottle label to avoid confusion. 

• IVT cRNA Binding Buffer may form a precipitate upon storage. If 
necessary, redissolve by warming in a water bath at 30°C, and then 
place the buffer at room temperature. 

• All steps of the protocol should be performed at room temperature. 
During the procedure, work without interruption. 

1. Add 60 µL of RNase-free Water to the IVT reaction and mix by vortexing for 3 seconds. 

2. Add 350 µL IVT cRNA Binding Buffer to the sample and mix by vortexing for 3 seconds. 

3. Add 250 µL ethanol (96–100%) to the mixture, and mix well by pipetting. Do not centrifuge. 

4. Apply sample (700 µL) to the IVT cRNA Cleanup Spin Column sitting in a 2 mL Collection Tube. 
Centrifuge for 15 seconds at ≥8,000 x g (≥10,000 rpm). Discard flow-through and Collection Tube. 

5. Transfer the spin column into a new 2 mL Collection Tube (supplied). Pipet 500 µL IVT cRNA 
Wash Buffer onto the spin column. Centrifuge for 15 seconds at ≥8,000 x g (≥10,000 rpm) to wash. 
Discard flow-through. 

 

IVT cRNA Wash Buffer is supplied as a concentrate. Ensure that ethanol is 
added to the IVT cRNA Wash Buffer before use (see IMPORTANT note above 
before starting). 

6. Pipet 500 µL 80% (v/v) ethanol onto the spin column and centrifuge for 15 seconds at ≥8,000 x g 
(≥10,000 rpm). Discard flow-through. 
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7. Open the cap of the spin column and centrifuge for 5 minutes at maximum speed (≤25,000 x g). 
Discard flow-through and Collection Tube. 

Place columns into the centrifuge using every second bucket. Position caps over the adjoining bucket 
so that they are oriented in the opposite direction to the rotation (i.e., if the microcentrifuge rotates in 
a clockwise direction, orient the caps in a counterclockwise direction). This avoids damage of the 
caps. 

 

Label the collection tubes with the sample name. During centrifugation some column 
caps may break, resulting in loss of sample information. 

Centrifugation with open caps allows complete drying of the membrane. 

8. Transfer spin column into a new 1.5 mL Collection Tube (supplied), and pipet 11 µL of RNase-free 
Water directly onto the spin column membrane. Ensure that the water is dispensed directly onto the 
membrane. Centrifuge 1 minute at maximum speed (≤25,000 x g) to elute. 

9. Pipet 10 µL of RNase-free Water directly onto the spin column membrane. Ensure that the water is 
dispensed directly onto the membrane. Centrifuge 1 minute at maximum speed (≤25,000 x g) to elute. 

10. For subsequent photometric quantification of the purified cRNA, we recommend dilution of the 
eluate between 1:100 fold and 1:200 fold. 

11. Store cRNA at –20°C, or –70°C if not quantitated immediately. Alternatively, proceed to Step 2: 
Quantification of the cRNA. 

Step 2: Quantification of the cRNA 
Use spectrophotometric analysis to determine the cRNA yield. Apply the convention that 1 absorbance unit 
at 260 nm equals 40 µg/mL RNA. 

• Check the absorbance at 260 nm and 280 nm to determine sample concentration and purity. 

• Maintain the A260/A280 ratio close to 2.0 for pure RNA (ratios between 1.9 and 2.1 are acceptable). 

For quantification of cRNA when using total RNA as starting material, an adjusted cRNA yield must be 
calculated to reflect carryover of unlabeled total RNA. Using an estimate of 100% carryover, use the 
formula below to determine adjusted cRNA yield: 

adjusted cRNA yield = RNAm - (total RNAi) (y) 

RNAm = amount of cRNA measured after IVT (µg) 

total RNAi = starting amount of total RNA (µg) 

y = fraction of cDNA reaction used in IVT 

Example: Starting with 10 µg total RNA, 50% of the cDNA reaction is added to the IVT, giving a yield of 50 
µg cRNA. Therefore, adjusted cRNA yield = 50 µg cRNA - (10 µg total RNA) (0.5 cDNA reaction) = 45.0 µg. 

Use adjusted yield in Fragmenting the cRNA for Target Preparation. 

 

Refer to Chapter 3 Eukaryotic Target Hybridization for the amount of cRNA 
required for one array hybridization experiment. The amount varies depending 
on the array format. Refer to the specific probe array package insert for 
information on the array format. 
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Step 3: Checking Unfragmented Samples by Gel Electrophoresis 
Gel electrophoresis of the IVT product is done to estimate the yield and size distribution of labeled 
transcripts. The following are examples of typical cRNA products examined on an Agilent 2100 
Bioanalyzer. 

Figure 2.3 Biotin-labeled cRNA from One-Cycle cDNA Synthesis Kit. Bioanalyzer electropherogram for 
labeled cRNA from HeLa total RNA using the One-Cycle Kit. This electropherogram displays the 
nucleotide size distribution for 400 ng of labeled cRNA resulting from one round of amplification. The 
average size is approximately 1580 nt. 

 

Figure 2.4 Biotin-labeled cRNA from Two-Cycle cDNA Synthesis Kit. Bioanalyzer electropherogram for 
labeled cRNA from HeLa total RNA using the Two-Cycle Kit. This electropherogram displays the 
nucleotide size distribution for 400 ng of labeled cRNA resulting from two rounds of amplification. The 
average size is approximately 850 nt. 
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Fragmenting the cRNA for Target Preparation 
Sample Cleanup Module is used for this step. 

Fragmentation of cRNA target before hybridization onto GeneChip™ probe arrays has been shown to be 
critical in obtaining optimal assay sensitivity. 

We recommend that the cRNA used in the fragmentation procedure be sufficiently concentrated to 
maintain a small volume during the procedure. This will minimize the amount of magnesium in the final 
hybridization cocktail. Fragment an appropriate amount of cRNA for hybridization cocktail preparation 
and gel analysis (refer to Chapter 3, Eukaryotic Target Hybridization). 

1. The Fragmentation Buffer has been optimized to break down full-length cRNA to 35 to 200 base 
fragments by metal-induced hydrolysis. 

The following table shows suggested fragmentation reaction mix for cRNA samples at a final 
concentration of 0.5 µg/µL. Use adjusted cRNA concentration, as described in Step 2: Quantification of 
the cRNA. The total volume of the reaction may be scaled up or down dependent on the amount of 
cRNA to be fragmented. 

Table 2.19 Sample Fragmentation Reaction by Array Format* 

Component 49/64 Format 100 Format 

cRNA 20 µg (1 to 21 µL) 15 µg (1 to 21 µL) 

5X Fragmentation Buffer 8 µL 6 µL 

RNase-free Water (variable) to 40 µL final volume to 30 µL final volume 

Total Volume 40 µL 30 µL 

*Refer to specific probe array package insert for information on array format. 

2. Incubate at 94°C for 35 minutes. Put on ice following the incubation. 

3. Save an aliquot for analysis on the Bioanalyzer. A typical fragmented target is shown in Figure 2.5. 

The standard fragmentation procedure should produce a distribution of RNA fragment sizes from 
approximately 35 to 200 bases. 

4. Store undiluted, fragmented sample cRNA at –20°C (or –70°C for longer-term storage) until ready to 
perform the hybridization, as described in Chapter 3, Eukaryotic Target Hybridization. 

Figure 2.5 Fragmented cRNA. Bioanalyzer electropherogram for fragmented labeled cRNA from HeLa 
total RNA. This electropherogram displays the nucleotide size distribution for 150 ng of fragmented labeled 
cRNA resulting from one round of amplification. The average size is approximately 100 nt. 
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Chapter 3 Eukaryotic Target Hybridization 
This Chapter Contains: 

• Detailed steps for preparing the eukaryotic hybridization mix containing labeled target and control 
cRNA. 

• Instructions for hybridizing the target mix to a eukaryotic GeneChip™ probe array. 

After completing the procedures described in this chapter, the hybridized probe array is ready for washing, 
staining, and scanning, as detailed in the GeneChip™ Expression Wash, Stain and Scan User Manual, P/N 
702731. 

Reagents and Materials Required 
The following reagents and materials have been tested and evaluated by our scientists. Information and 
part numbers listed are based on U.S. catalog information. For supplier information, refer to the Supplier 
Reference List in Appendix F of this manual. 

• GeneChip™ Hybridization, Wash and Stain Kit: P/N 900720 (30 reactions) 

Hybridization Module from Box 1: 

- Pre-Hybridization Mix 

- 2X Hybridization Mix 

- DMSO 

- Nuclease-free Water 

• GeneChip™ Eukaryotic Hybridization Control Kit: P/N 900454 (30 reactions) or P/N 900457 (150 
reactions), both contain Control cRNA and Control Oligo B2 

• Control Oligo B2, 3 nM: P/N 900301 

Miscellaneous Supplies 
• Hybridization Oven 640: P/N 800138 (110V) or 800139 (220V) 

• Sterile, RNase-free, microcentrifuge vials, 1.5 mL: USA Scientific, P/N 1415-2600 (or equivalent) 

• Micropipettors, (P-2, P-20, P-200, P-1000): Rainin Pipetman (or equivalent) 

• Sterile-barrier pipette tips and non-barrier pipette tips 

• Heatblock 
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Eukaryotic Target Hybridization 
Refer to the table below for the necessary amount of cRNA required for the specific probe array format 
used. These preparations take into account that it is necessary to make extra hybridization cocktail due to a 
small loss of volume (10–20 µL) during each hybridization. 

1. Mix the following for each target, scaling up volumes if necessary for hybridization to multiple probe 
arrays. 

 

If using the GeneChip™ IVT Labeling Kit to prepare the target, a final 
concentration of 10% DMSO needs to be added in the hybridization cocktail 
for optimal results. 

 

 

DMSO will solidify when stored at 4°C. Ensure that the reagent is completely 
thawed prior to use. After the first use, it is recommended to store DMSO at 
room temperature. 

Table 3.1 
Hybridization Cocktail for Single Probe Array* 

Component 49 Format  
(Standard)  
64 Format Array 

100 Format 
(Midi) Array 

169 Format (Mini) 
Array /400 
Format 
(Micro) Array 

Final Dilution 

Fragmented and Labeled cRNA† 15 µg 10 µg 5 µg 0.05 µg/µL 

Control Oligonucleotide B2 (3 
nM) 

5 µL 3.3 µL 1.7 µL 50 pM 

20X Eukaryotic Hybridization 
Controls (bioB, bioC, bioD, cre) 

15 µL 10 µL 5 µL 1.5, 5, 25, and 
100 pM 
respectively 

2X Hybridization Mix 150 µL 100 µL 50 µL 1X 

DMSO 30 µL 20 µL 10 µL 10% 

Nuclease-free Water to final volume 
of 300 µL 

to final 
volume 
of 200 µL 

to final volume 
of 100 µL 

 

Total Volume 300 µL 200 µL 100 µL  

*Refer to specific probe array package insert for information on array format. 
†See Chapter 2 for the amount of adjusted fragmented cRNA to use when starting from total RNA. 

 
It is imperative that frozen stocks of 20X GeneChip™ Eukaryotic 
Hybridization Controls are heated to 65°C for 5 minutes to completely 
resuspend the cRNA before aliquoting. 

2. Equilibrate probe array to room temperature immediately before use. 

 

It is important to allow the arrays to equilibrate to room temperature 
completely. Specifically, if the rubber septa are not equilibrated to room 
temperature, they may be prone to cracking, which can lead to leaks. 
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3. Heat the hybridization cocktail to 99°C for 5 minutes in a heat block. 

4. Meanwhile, wet the array with an appropriate volume of Pre-Hybridization Mix (see Table 3.2) by 
filling it through one of the septa. 

Table 3.2 
Probe Array Cartridge Volumes for Pre-Hybridization Mix and Hybridization Cocktail 

Array Volume 

49 Format (Standard) 200 µL 

64 Format 200 µL 

100 Format (Midi) 130 µL 

169 Format (Mini) 80 µL 

400 Format (Micro) 80 µL 

 

Each array has two septa (see Figure 3.1 for location of the probe array 
septa). In order to fill the array, first vent the array chamber by inserting a 
clean, unused pipette tip into one of the septa; then insert the pipette tip of a 
micropipettor into the remaining septum to fill. 

 

Figure 3.1 GeneChip™ Probe Array 

 

5. Incubate the probe array filled with Pre-Hybridization Mix at 45°C for 10 minutes with rotation. 

6. Transfer the hybridization cocktail that has been heated at 99°C, in Step 3, to a 45°C heat block for 5 
minutes. 

7. Spin the hybridization cocktail at maximum speed in a microcentrifuge for 5 minutes to collect any 
insoluble material from the hybridization mixture. 

8. Remove the array from the hybridization oven. Vent the array with a clean pipette tip and extract the 
Pre-Hybridization Mix from the array with a micropipettor. Refill the array with the appropriate 
volume of the clarified hybridization cocktail, avoiding any insoluble matter at the bottom of the 
tube (see Table 3.2). 

9. Place probe array into the hybridization oven, set to 45°C. 

10. To avoid stress to the motor, load probe arrays in a balanced configuration around the axis. Rotate at 
60 rpm. 

11. Hybridize for 16 hours. During the latter part of the 16-hour hybridization, proceed to the 
GeneChip™ Expression Wash, Stain and Scan User Manual, Pub. No. 702731, to prepare reagents for the 
washing and staining steps required immediately after completion of hybridization. 
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Chapter 4 Prokaryotic Target Preparation 
This Chapter Contains: 

This chapter describes the assay procedures recommended for use with the GeneChip™ P. aeruginosa 
Genome Array and the GeneChip™ E. coli arrays. The assay utilizes reverse transcriptase and random 
hexamer primers to produce DNA complementary to the RNA. The cDNA products are then fragmented 
by DNase I and labeled with terminal transferase and biotinylated GeneChip™ DNA Labeling Reagent at 
the 3' termini. 

This protocol is presented as a recommendation only, and has not been validated. 

Figure 4.1 Target Labeling for Prokaryotic GeneChipTM Antisense Arrays 
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Reagents and Materials Required 
The following reagents and materials are recommendations and have been tested and evaluated by our 
scientists. Information and part numbers listed are based on U.S. catalog information. For supplier 
information, refer to the Supplier Reference List in Appendix F of this manual. 

Labeling 
• dNTP: P/N 18427-013 

• Random Primers, 3 µg/µL: P/N 48190-011 

• GeneChip™ Eukaryotic Poly-A RNA Control Kit: P/N 900433 

• SuperScript II™ Reverse Transcriptase: P/N 18064-071 

• SUPERase•In™: P/N 2696 

• Nuclease-free Water: P/N 9930 

• NaOH, 1N solution: VWR Scientific Products, P/N MK469360 

• HCl, 1N solution: VWR Scientific Products, P/N MK638860 

• MinElute PCR Purification Kit: QIAGEN, P/N 28004 

• 10X DNase I Buffer: P/N 78331 

• Deoxyribonuclease I (DNase I): P/N 89835 

• GeneChip™ DNA Labeling Reagent: P/N 900542 

• Terminal Deoxynucleotidyl Transferase: Promega, P/N M1875 

• EDTA, 0.5M, pH 8.0: P/N 15575-020 

• Non-stick RNase-free microfuge tubes, 0.5 mL and 1.5 mL: P/N 12350 and P/N 12450, respectively 

Gel-Shift Assay 
• Novex XCell SureLock™ Mini-Cell: P/N EI0001 

• 4-20% TBE Gel, 1.0 mm, 12 well: P/N EC62252 

• Sucrose Gel Loading Dye, 5X: Amresco, P/N E-274 

• 10X TBE Running Buffer 

• SYBR Gold: P/N S-11494 

• 10 bp and 100 bp DNA ladder: P/N 10821-015 and 15628-019, respectively 

• ImmunoPure NeutrAvidin: P/N 31000 

• 1M Tris, pH 7.0: P/N 9850G 

• PBS, pH 7.2: P/N 20012-027 
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Reagent Preparation 

75 ng/µL Random Primers 
For 1000 µL: 

25 µL of 3 µg/µL Random Primers 

975 µL of Nuclease-free H2O 

Store at –20°C in a non-frost-free freezer. 

2 mg/mL NeutrAvidin 
Resuspend 10 mg NeutrAvidin in 5 mL PBS solution. Store at 4°C. 

Total RNA Isolation 
As starting material for the cDNA synthesis procedure, total RNA can be isolated by using standard 
procedures for bacterial RNA isolation or various commercial RNA isolation kits. 

For Pseudomonas aeruginosa and E. coli, we have successfully used the QIAGEN™ RNeasy Mini Purification 
Kit. Caution should be used to minimize chromosomal DNA contamination during the isolation, due to the 
high sensitivity of the assay. It is suggested that no more than 1 X 109 cells are applied to a single 
purification column. Also, use the lysozyme at a concentration of 1 mg/mL, and not the recommended 400 
µg/mL. Additional DNase I treatment may be required to eliminate DNA contamination when the bacterial 
culture is grown at high density. 

After purification, RNA concentration is determined by absorbance at 260 nm on a spectrophotometer (1 
absorbance unit = 40 µg/mL RNA). The A260/A280 ratio should be approximately 2.0, with ranges between 
1.8 to 2.1 considered acceptable. We recommend checking the quality of RNA by running it on an agarose 
gel prior to starting the assay. The 23S and 16S rRNA bands should be clear without any obvious smears. 
Any indication of the presence of chromosomal DNA contamination (high molecular weight bands or 
smears on the gel) would require additional DNase treatment before proceeding to cDNA synthesis. 

Figure 4.2 Typical RNA preparation from E. coli 
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cDNA Synthesis 
The following protocol starts with 10 µg of total RNA. Incubations are performed in a thermal cycler. 

 

The integrity of total RNA is essential for the success of the assay. Exercise 
precautions and follow standard laboratory procedures when handling RNA 
samples. 

Step 1: Preparation of Poly-A RNA Controls 
The Poly-A RNA Control Stock and Poly-A Control Dil Buffer are provided with the Poly-A RNA 
Control Kit (P/N 900433) to prepare the appropriate serial dilutions based on the following 
recommendation: 

Table 4.1 Serial Dilutions of Poly-A RNA Control Stock 

Array Format* Serial Dilutions Spike-in Volumes 

 First Second  

169 Format (Mini) 1:20 1:16 2 µL 

100 Format (Midi) 1:20 1:20 2 µL 

49 Format (Standard) 1:20 1:13 2 µL 

*Refer to specific probe array package insert for information on array format. 

 

Avoid pipetting solutions less than 2 µL in volume to maintain precision and 
consistency when preparing the dilutions. 

The Poly-A RNA Control Stock contains in vitro synthesized, polyadenylated transcripts for B. subtilis 
genes that are pre-mixed at staggered concentrations. The concentrations of the spikes in the stock solution 
are: lys 7.6 nM, phe 15.2 nM, thr 30.4 nM, and dap 114.0 nM. Following the recommended dilutions as shown 
above, the final concentrations of the spikes in the hybridization cocktail (Table 5.1) are lys 0.256 pM, phe 
0.511 pM, thr 1.022 pM, and dap 3.833 pM. 

 

We strongly recommend using control transcripts to monitor the assay 
sensitivity and performance. Probe sets for these control genes from B. 
subtilis have been tiled on the GeneChip™ P. aeruginosa Genome Array and 
E. coli arrays. 

For example, to prepare the poly-A RNA dilutions for a 100 format array: 

 
Use non-stick RNase-free microfuge tubes to prepare all of the dilutions. 

1. Add 2 µL of the Poly-A RNA Control Stock to 38 µL of Poly-A Control Dil Buffer for the First 
Dilution (1:20). 

2. Mix thoroughly and spin down to collect the liquid at the bottom of the tube. 

3. Add 2 µL of the First Dilution to 38 µL of Poly-A Control Dil Buffer to prepare the Second Dilution 
(1:20). 

4. Mix thoroughly and spin down to collect the liquid at the bottom of the tube. 

5. Add 2 µL of this Second Dilution to the total RNA as indicated in Table 4.2. 
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The First Dilution of the poly-A RNA controls can be stored up to six weeks in 
a non-frost-free freezer at –20°C and frozen-thawed up to eight times. 

Step 2: cDNA Synthesis 
1. Prepare the following mixture for primer annealing: 

Table 4.2 RNA/Primer Hybridization Mix 

Component Volume Final Dilution 

Total RNA 10 µg 0.33 µg/µL 

75 ng/µL Random Primers 10 µL 25 ng/µL 

Diluted poly-A RNA controls 2 µL Variable 

Nuclease-free H2O Up to 30.0 µL — 

Total Volume 30 µL  

 

The random primers supplied by Invitrogen Life Technologies are 
oligodeoxynucleotides composed mainly of hexamers. Random primers of 
different length or GC content have been successfully applied to the 
procedure. 

2. Incubate the RNA/Primer mix at the following temperatures: 

• 70°C for 10 minutes 

• 25°C for 10 minutes 

• Chill to 4°C 

3. Prepare the reaction mix for cDNA synthesis. Briefly centrifuge the reaction tube to collect sample at 
the bottom and add the cDNA synthesis mix from Table 4.3 to the RNA/primer hybridization mix. 

Table 4.3 cDNA Synthesis Components 

Component Volume Final Dilution 

RNA/Primer hybridization 
mix (from previous step) 

30 µL  

5X 1st Strand Buffer 12 µL 1X 

100 mM DTT 6 µL 10 mM 

10 mM dNTPs 3 µL 0.5 mM 

SUPERase•In (20 U/µL) 1.5 µL 0.5 U/µL 

SuperScript II (200 U/µL) 7.5 µL 25 U/µL 

Total Volume 60 µL  

4. Incubate the reaction at the following temperatures: 

• 25°C for 10 minutes 

• 37°C for 60 minutes 

• 42°C for 60 minutes 

• Inactivate SuperScript II at 70°C for 10 minutes 

• Chill to 4°C 
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Step 3: Removal of RNA 
1. Add 20 µL of 1N NaOH and incubate at 65°C for 30 minutes. 

2. Add 20 µL of 1N HCl to neutralize. 

Step 4: Purification and Quantitation of cDNA 
1. Use MinElute PCR Purification Columns to clean up the cDNA synthesis product (for detailed 

protocol, see MinElute PCR Purification Kit Protocols provided by the supplier). Elute the product 
with 12 µL of EB Buffer (supplied with the kit). The average volume of eluate is 11 µL from 12 µL of 
EB Buffer. 

2. Quantify the purified cDNA product by 260 nm absorbance (1.0 A260 unit = 33 µg/mL of single-
stranded DNA). 

 

Typical yields of cDNA are 3 to 7 µg. A minimum of 1.5 µg of cDNA is 
required for subsequent procedures to obtain sufficient material to 
hybridize onto the array and to perform necessary quality control 
experiments. 

cDNA Fragmentation 
1. Prepare the following reaction mix: 

Table 4.4 Fragmentation Reaction 

Component Volume Dilution 

10X DNase I Buffer 2 µL 1X 

cDNA 10 µL – 

DNase I (see note below) X µL 0.6 U/µg of cDNA 

Nuclease-free H2O Up to 20 µL – 

Total Volume 20 µL  

 

 

Use all remaining cDNA purified from the previous step in this reaction. Do 
not proceed if the yield is lower than 1.5 µg. Dilute DNase I to 0.6 U/µL in 1X 
One-Phor-All Buffer. Prepare fresh dilution each time immediately before 
use. 

 

 
It is anticipated that DNase I enzyme activity may vary from lot to lot. A 
titration assay is strongly recommended for each new lot of enzyme to 
determine the dosage of the DNase I (unit of DNase I per µg of cDNA) to be 
used in the fragmentation reaction. 0.6U for each µg of cDNA can be used 
as a starting point for the titration. 

2. Incubate the reaction at 37°C for 10 minutes. 

3. Inactivate DNase I at 98°C for 10 minutes. 

4. The fragmented cDNA is applied directly to the terminal labeling reaction. Alternatively, the 
material can be stored at –20°C for later use. 
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To examine the fragmentation result, load ~200 ng of the product on a 4% to 
20% acrylamide gel and stain with SYBR Gold. The majority of the 
fragmented cDNA should be in the 50 to 200 base-pairs range. 

Terminal Labeling 
Use GeneChip™ DNA Labeling Reagent (P/N 900542) to label the 3' termini of the fragmentation products. 

1. Prepare the following reaction mix: 

Table 4.5 Terminal Label Reaction 

Component Volume 

5X Reaction Buffer 10 µL 

GeneChip™ DNA Labeling Reagent, 7.5 mM 2 µL 

Terminal Deoxynucleotidyl Transferase 2 µL 

Fragmentation cDNA Product Up to 20 µL 

H2O 16 µL 

Total Volume 50 µL 

2. Incubate the reaction at 37°C for 60 minutes. 

3. Stop the reaction by adding 2 µL of 0.5M EDTA. 

4. The target is ready to be hybridized onto probe arrays, as described in Prokaryotic Target 
Hybridization. Alternatively, it may be stored at –20°C for later use. 

To estimate the labeling efficiency, a gel-shift assay can be performed (see below). In general, greater than 
90% of the fragments should be labeled and, therefore, shifted. 

Gel-Shift Assay 
The efficiency of the labeling procedure can be assessed using the following procedure. This quality control 
protocol prevents hybridizing poorly labeled target onto the probe array. The addition of biotin residues is 
monitored in a gel-shift assay, where the fragments are incubated with avidin prior to electrophoresis. The 
nucleic acids are then detected by staining, as shown in the gel photograph Figure 4.3. The procedure takes 
approximately 90 minutes to complete. 

 

The absence of a shift pattern indicates poor biotin labeling. The problem 
should be addressed before proceeding to the hybridization step. 
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Figure 4.3 Gel-shift for monitoring P. aeruginosa target labeling efficiency. Notice that the majority of 
the avidin-conjugated product, in both lanes 3 and 5, is highlighted as a bright band towards the top of the 
gel. 

 

1. Prepare a NeutrAvidin solution of 2 mg/mL in PBS. 

2. Place a 4% to 20% TBE gel into the gel holder and load system with 1X TBE Buffer. 

3. For each sample to be tested, remove two 150 to 200 ng aliquots of fragmented and biotinylated 
sample to fresh tubes. 

4. Add 5 µL of 2 mg/mL NeutrAvidin to one of the two tubes for each sample tested. 

5. Mix and incubate at room temperature for 5 minutes. 

6. Add loading dye to all samples to a final concentration of 1X loading dye. 

7. Prepare 10 bp and 100 bp DNA ladders (1 µL ladder +7 µL water+2 µL loading dye for each lane). 

8. Carefully load samples and two ladders on gel. Each well can hold a maximum of 20 µL. 

9. Run the gel at 150 volts until the front dye (red) almost reaches the bottom. The electrophoresis takes 
approximately 1 hour. 

10. While the gel is running, prepare at least 100 mL of a 1X solution of SYBR Gold for staining. 

 

SYBR Gold is light sensitive. Therefore, use caution and shield the staining 
solution from light. Prepare a new batch of stain at least once a week. 

11. After the gel is complete, break open cartridge and stain the gel in 1X SYBR Gold for 10 minutes. 

12. Place the gel on the UV light box and produce an image following standard procedure. Be sure to use 
the appropriate filter for SYBR Gold. 
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Chapter 5 Prokaryotic Target Hybridization 
This Chapter Contains: 

This chapter contains detailed steps for preparing the hybridization mix, and instructions for hybridizing 
the target mix to the GeneChip™ P. aeruginosa Genome Array and GeneChip™ E. coli arrays. The 
hybridized probe array is then ready for washing, staining, and scanning as detailed in Chapter 6. 

Reagents and Materials Required 
The following reagents and materials have been tested and evaluated by our scientists. Information and 
part numbers listed are based on U.S. catalog information. For supplier information, refer to the Supplier 
Reference List in Appendix F of this manual. 

• GeneChip™ Hybridization, Wash and Stain Kit: P/N 900720 (30 reactions) 
Hybridization Module, Box 1 

- 2X Hybridization Mix 

- DMSO 

- Nuclease-free Water 

• Control Oligo B2, 3 nM: P/N 900301 

Miscellaneous Supplies 
• Hybridization Oven 640: P/N 800138 (110V) or 800139 (220V) 

• Sterile, RNase-free, microcentrifuge vials, 1.5 mL: USA Scientific, P/N 1415-2600 (or equivalent) 

• Micropipettors, (P-2, P-20, P-200, P-1000): Rainin Pipetman (or equivalent) 

• Sterile-barrier pipette tips and non-barrier pipette tips 

Prokaryotic Target Hybridization 
After determining that the fragmented cDNA is labeled with biotin, prepare the hybridization cocktail. The 
minimum amount of cDNA product required for target hybridization is 1 µg. The solution is stable for 
approximately 6 to 8 hours at 4°C. The following protocol can be used for freshly prepared or frozen 
hybridization cocktail. Re-use of prokaryotic sample has not been thoroughly tested and, therefore, is not 
recommended. 

1. Prepare the following hybridization cocktail. 

 

DMSO will solidify when stored at 4°C. Ensure that the reagent is 
completely thawed prior to use. After the first use, it is recommended to 
store DMSO at room temperature. 
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Table 5.1 Hybridization Cocktail for Single Probe Array* 

Component 49 Format 
(Standard) 

100 Format 
(Midi) 

169 Format 
(Mini) 

Final Dilution 
or Amount 

Fragmented and Labeled cDNA Up to 50 µL Up to 50 µL 25 µL 0.5 – 7.0 µg 

Control Oligonucleotide B2 (3 
nM) 

3.3 µL 2.2 µL 1.3 µL 50 pM 

2X Hybridization Mix 100 µL 65 µL 40 µL 1X 

DMSO – 10.2 µL 6.2 µL 7.8% (or 0%) 

Nuclease-free Water to a final volume 
of 200 µL 

to a final 
volume of 

130 µL 

7.5 µL  

Total Volume 200 µL 130 µL 80 µL  

*Refer to specific probe array package insert for information on array format. 

2. Equilibrate probe array to room temperature immediately before use. 

 

It is important to allow the arrays to equilibrate to room temperature 
completely. Specifically, if the rubber septa are not equilibrated to room 
temperature, they may be prone to cracking, which leads to leaks. 

3. Based on the format of the array type used, refer to Table 5.2 to add the appropriate volume of 
hybridization cocktail. 

Table 5.2 Probe Array Cartridge Volumes for Hybridization Cocktail 

Array Volume 

49 Format (Standard) 200 µL 

100 Format (Midi) 130 µL 

169 Format (Mini) 80 µL 

 

 

Each array has two septa (see Figure 5.1 for location of the probe array 
septa). In order to fill the array, first vent the array chamber by inserting a 
clean, unused pipette tip into one of the septa; then insert the pipette tip of a 
micropipettor into the remaining septum to fill. 
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Figure 5.1 GeneChip™ Probe Array 

 

4. Place probe array in the hybridization oven set at the temperatures indicated below. 

• P. aeruginosa  50°C 

• E. coli   45°C 

 

The hybridization temperature of 50°C is higher than that used for other 
expression assays. The increased hybridization temperature is required 
due to the high GC content of P. aeruginosa. 

5. To avoid stress to the motor, load probe arrays in a balanced configuration around axis. Rotate at 60 
rpm. 

6. Hybridize for 16 hours. 

During the latter part of the 16-hour hybridization, proceed to Chapter 6 to prepare reagents for the 
washing and staining steps required immediately after completion of hybridization. 
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Chapter 6 Prokaryotic Arrays: Washing, Staining and 
Scanning 
This Chapter Contains: 

• Instructions for using the Fluidics Station 400 or 450/250 to automate the washing and staining of 
GeneChip™ P. aeruginosa and GeneChip™ E. coli arrays. 

• Instructions for scanning probe arrays using the GeneArray™ Scanner or the GeneChip™ Scanner 
3000. 

After completing the procedures described in this chapter, the scanned probe array image (.dat file) is 
ready for analysis, as explained in the enclosed GeneChip™ Expression Analysis: Data Analysis Fundamentals 
booklet (Pub. No. 701190). 

Reagents and Materials Required 
The following reagents and materials have been tested and evaluated by our scientists. Information and 
part numbers listed are based on U.S. catalog information. For supplier information, refer to the Supplier 
Reference List in Appendix F of this manual. 

• GeneChip™ Hybridization, Wash and Stain Kit: P/N 900720 (30 reactions) 
Stain Module, Box 1 

- Stain Cocktail 1 

- Stain Cocktail 2 

- Array Holding Buffer 

Wash Buffers A and B, Box 2 

- Wash Buffer A (P/N 900721) 

- Wash Buffer B (P/N 900722) 

• RNase-free water 

Miscellaneous Supplies 
• Fluidics Station 450: P/N 00-0079 

• GeneChip™ Scanner 3000: P/N 00-00212 

• Sterile, RNase-free, microcentrifuge vials, 1.5 mL: USA Scientific, P/N 1415-2600 (or equivalent) 

• Sterile, RNase-free, microcentrifuge vials, 1.5 mL, amber: USA Scientific, P/N 1615-5507 (or 
equivalent) 

• Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman (or equivalent) 

• Sterile-barrier pipette tips and non-barrier pipette tips 

• Tygon Tubing, 0.04″ inner diameter: Cole-Parmer, P/N H-06418-04 

• Tough-Spots™, Label Dots: USA Scientific, P/N 9185-0000 

• Media Bottle, SQ, 1,000 mL: P/N 400119 

• Media Bottle, SQ, 500 mL (set of 3): P/N 400118 

• Bottle Cap, Pre-Drilled (set of 4): P/N 400137 
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Experiment and Fluidics Station Setup 
Step 1: Defining File Locations 
Before working with Microarray Suite it is important to define where the program will store and look for 
files. 

 
For GeneChipTM Operating Software (GCOS), this step is not necessary. Proceed 
directly to Step 2: Entering Experiment Information. 

1. Launch Microarray Suite from the workstation and select Tools → Defaults → File Locations from 
the menu bar. 

2. The File Locations window displays the locations of the following files: 

• Probe Information (library files, mask files) 

• Fluidics Protocols (fluidics station scripts) 

• Experiment Data (.exp, .dat, .cel, and .chp files are all saved to location selected here) 

3. Verify that all three file locations are set correctly and click OK. Contact Technical Support if you 
have any questions regarding this procedure. 

Step 2: Entering Experiment Information 
To wash, stain, and scan a probe array, an experiment must first be registered in GCOS or Microarray Suite. 
Follow the instructions detailed in the “Setting Up an Experiment” section of the appropriate GeneChip™ 
Operating Software User’s Guide or Microarray Suite User’s Guide. 

The fields of information required for registering experiments in Microarray Suite are: 

• Experiment Name 

• Probe Array Type 

In GCOS, three additional fields are required: 

• Sample Name 

• Sample Type 

• Project 

Sample templates, experiment templates, and array barcodes can also be employed in GCOS to standardize 
and simplify the registration process. See the GCOS User’s Guide for more information. 

The Project, Sample Name, and Experiment Name fields establish a sample hierarchy that organizes 
GeneChip™ gene expression data in GCOS. In terms of the organizational structure, the Project is at the top 
of the hierarchy, followed by Sample Name, and then Experiment Name. 
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STEP 3: PREPARING THE FLUIDICS STATION 
The Fluidics Station 400, or 450/250 is used to wash and stain the probe arrays. It is operated using 
GCOS/Microarray Suite. 

Setting Up the Fluidics Station 
1. Turn on the Fluidics Station using the switch on the lower left side of the machine. 

2. Select Run → Fluidics from the menu bar. 

The Fluidics Station dialog box appears with a drop-down list for selecting the experiment name for 
each of the fluidics station modules. A second list is accessed for choosing the Protocol for each of the 
four fluidics station modules. 

 
Refer to the appropriate GeneChip™ Fluidics Station User’s Guide for 
instructions on connecting and addressing multiple fluidics stations. 

Priming the Fluidics Station 
Priming ensures that the lines of the fluidics station are filled with the appropriate buffers and the fluidics 
station is ready for running fluidics station protocols. 

Priming should be done: 

• When the fluidics station is first started 

• When wash solutions are changed 

• Before washing if a shutdown has been performed 

• If the LCD window instructs the user to prime 

1. Select Protocol in the Fluidics Station dialog box. 

2. Choose Prime or Prime_450 for the respective modules in the Protocol drop-down list. 

3. Ensure that the designated Fluidics Station Wash A and Wash B media bottles are clean. Transfer 
Wash Buffer A and Wash Buffer B from the kit to the clean, empty Fluidics Station bottles. 

4. If using Microarray Suite, click Run for each module to begin priming. If using GCOS, select the All 
Modules check box, then click Run. 
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Probe Array Wash and Stain 

 
The wash and stain procedure described below is different from previous 
recommended protocols. Closely adhere to the following recommendations for 
best results. 

After 16 hours of hybridization remove the array from the hybridization oven. Vent the array by inserting a 
clean pipette tip into one of the septa, and extract the hybridization cocktail with a pipettor through the 
remaining septum. Refill the probe array completely with the appropriate volume of Wash Buffer A, as 
given in Table 6.1. 

Table 6.1 Probe Array Cartridge Volumes for Wash Buffer A and Array Holding Buffer 

Array Total Fill Volume 

49 Format (Standard) 250 µL 

100 Format (Midi) 160 µL 

169 Format (Mini) 100 µL 

 

 
If necessary, at this point, the probe array can be stored at 4°C for up to 3 hours 
before proceeding with washing and staining. Equilibrate the probe array to 
room temperature before washing and staining. 

This procedure takes approximately 75 to 90 minutes to complete. 

PREPARING THE STAIN REAGENTS 
Prepare the following reagents. Volumes given are sufficient for one probe array. 

1. Remove Stain Cocktail 1, Stain Cocktail 2, and Array Holding Buffer from the Stain Module, Box 1. 

2. Gently tap the bottles to mix well. 

3. Aliquot the following reagents: 

a. 600 µL of Stain Cocktail 1 into a 1.5 mL amber microcentrifuge vial. 

b. 600 µL of Stain Cocktail 2 into a 1.5 mL (clear) microcentrifuge vial. 

c. 800 µL of Array Holding Buffer into a 1.5 mL (clear) microcentrifuge vial. 

4. Spin down all vials to remove the presence of any air bubbles. 

 
Stain Cocktail 1 is light-sensitive. Be sure to use amber microcentrifuge vials 
when aliquoting. 

 

 

The 600 µL of Stain Cocktail 1 will be used for the first and third stain. If 
using the Fluidics Station 400, after the first staining step is completed, save 
the vial with the Stain Cocktail 1 solution and reuse for the third staining 
step. 

For instructions on how to use the solutions and determining which Fluidics Script(s) fits your application, 
follow the instructions for using the Fluidics Station 450/250, or the instructions for using the Fluidics 
Station 400. 
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USING THE FLUIDICS STATION 450/250 

Washing and Staining the Probe Array 
1. In the Fluidics Station dialog box on the workstation, select the correct experiment name from the 

drop-down Experiment list. The Probe Array Type appears automatically. 

2. In the Protocol drop-down list, select the appropriate antibody amplification protocol to control the 
washing and staining of the probe array format being used: Table 6.2 and Table 6.3. 

Table 6.2 Fluidics Protocols for Fluidics Station 450/250 

FS450_0006 Flex FS450_0002 Modified 
Flex FS450_0002 for 
P. aeruginosa Array* 

FS450_0005 

Array 
Format 

169 100 100 49 

Post 
Hyb 
Wash #1 

10 cycles of 2 
mixes/ cycle with 
Wash Buffer A at 
30°C 

10 cycles of 2 
mixes/ cycle with 
Wash Buffer A at 
30°C 

10 cycles of 2 mixes/ 
cycle with Wash 
Buffer A at 25°C 

10 cycles of 2 mixes/ 
cycle with Wash 
Buffer A at 25°C 

Post 
Hyb 
Wash #2 

4 cycles of 15 
mixes/ cycle with 
Wash Buffer B at 
50°C 

6 cycles of 15 
mixes/ cycle with 
Wash Buffer B at 
50°C 

4 cycles of 15 mixes/ 
cycle with Wash 
Buffer B at 50°C 

4 cycles of 15 mixes/ 
cycle with Wash 
Buffer B at 45°C 

1st 
Stain 

Stain the probe 
array for 300 
seconds with Stain 
Cocktail 1 at 35°C 

Stain the probe 
array for 300 
seconds with Stain 
Cocktail 1 at 35°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 1 at 
25°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 1 at 
25°C. 

Post 
Stain 
Wash 

10 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
30°C 

10 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
30°C 

10 cycles of 4 mixes/ 
cycle with Wash 
Buffer A at 30°C 

10 cycles of 4 mixes/ 
cycle with Wash 
Buffer A at 30°C 

2nd 
Stain 

Stain the probe 
array for 300 
seconds with Stain 
Cocktail 2 at 35°C 

Stain the probe 
array for 300 
seconds with Stain 
Cocktail 2 at 35°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 2 at 
25°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 2 at 
25°C 

3rd 
Stain 

Stain the probe 
array for 300 
seconds with Stain 
Cocktail 1 at 35°C 

Stain the probe 
array for 300 
seconds with Stain 
Cocktail 1 at 35°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 1 at 
25°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 1 at 
25°C. 

Final 
Wash 

15 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
35°C 

15 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
35°C 

15 cycles of 4 mixes/ 
cycle with Wash 
Buffer A at 30°C 

15 cycles of 4 mixes/ 
cycle with Wash 
Buffer A at 30° 

Array 
Holding 
Buffer 

Fill the probe array 
with Array Holding 
Buffer 

Fill the probe array 
with Array Holding 
Buffer 

Fill the probe array 
with Array Holding 
Buffer 

Fill the probe array 
with Array Holding 
Buffer 

*Refer to Table 6.3 for instructions on how to modify Flex FS450_0002. 
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Table 6.3 Modification of Flex FS450_0002 for GeneChip™ P. aeruginosa Array 

GeneChip™ P. aeruginosa Genome Array requires a modification to the Flex FS450_0002 protocol. See 
below for details. 
The Flex FS450_0002 fluidics protocol must be modified. Follow the instructions carefully to make the 
modifications. Additionally, it is highly recommended that you save your new P. aeruginosa fluidics 
protocol under a different name to avoid confusion. 

1. Modify and save the fluidics protocol for the assay: 

a. Modify the fluidics protocol by using Tools → Edit Protocol drop-down list and selecting Flex 
FS450_0002 within the Protocol Name window. 

b. Change the following parameters: (Enter the new parameters by highlighting the default values 
and typing in the new values.) 

i. Wash A1 Temperature from 30°C to 25°C; 

ii. Number of Wash B Cycles from 6 to 4; 

iii. Stain Temperature (C) from 35°C to 25°C; 

iv. First Stain Time (seconds) from 300 to 600 seconds; 

v. Second Stain Time (seconds) from 300 to 600 seconds; 

vi. Third Stain Time (seconds) from 300 to 600 seconds; and 

vii. Wash A3 Temperature from 35°C to 30°C. 

c. Save the modified fluidics protocol by highlighting Flex FS450_0002 within the Protocol Name 
window and typing over with an assigned protocol name (e.g., Pae_cDNA). Click Save. The new 
fluidics protocol should be present in the Protocol drop-down list and is used in the subsequent 
steps. 

2. Select the name of the newly modified protocol (e.g., Pae_cDNA) from the Protocol drop-down list 
in the Fluidics Station dialog box. Select Run in the Fluidics Station dialog box to begin the washing 
and staining. Follow the instructions in the LCD window on the fluidics station.  

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
refer to the appropriate User’s Guide for your GeneChip™ Fluidics Station 450/250. 

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. Follow the 
instructions in the LCD window on the fluidics station. 

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
refer to the appropriate Fluidics Station User’s Guide, or Quick Reference Card (Pub. No. 08-0093 for the 
FS-450/250 fluidics stations). 

4. Insert the appropriate probe array into the designated module of the fluidics station while the 
cartridge lever is down, or in the eject position. When finished, verify that the cartridge lever is 
returned to the up, or engaged, position. 

5. Remove any microcentrifuge vial(s) remaining in the sample holder of the fluidics station module(s) 
being used. 

6. Follow the instructions on the LCD window of the fluidics station by placing the three experiment 
sample vials (the microcentrifuge vials) into the sample holders 1, 2, and 3 on the fluidics station. 

a. Place one vial containing 600 µL Stain Cocktail 1 in sample holder 1. 

b. Place one vial containing 600 µL Stain Cocktail 2 in sample holder 2. 

c. Place one vial containing 800 µL of Array Holding Buffer in sample holder 3. 

d. Press down on the needle lever to snap needles into position and to start the run. 
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The run begins. The Fluidics Station dialog box at the workstation terminal and the LCD window 
display the status of the washing and staining as the protocol progresses. 

7. When the protocol is complete, the LCD window displays the message EJECT & INSPECT 
CARTRIDGE. 

8. Remove the probe arrays from the fluidics station modules by first pressing down the cartridge lever 
to the eject position. 

9. Check the probe array window for large bubbles or air pockets. 

• If the probe array has no large bubbles, it is ready to scan on the GeneArray™ Scanner, or the 
GeneChip™ Scanner 3000. Pull up on the cartridge lever to close the washblock and proceed to 
Probe Array Scan. 

• If bubbles are present, do the following: 

Return the probe array to the probe array holder. Follow instructions on the LCD window. 
Engage the washblock by gently pushing up on the cartridge lever to the engaged, or closed, 
position. 

The fluidics station will drain the probe array and then fill it with a fresh volume of Array 
Holding Buffer. When it is finished, the LCD window will display EJECT AND INSPECT 
CARTRIDGE. Again, remove the probe array and inspect it for bubbles. If no bubbles are 
present, it is ready to scan. Pull up on the cartridge lever to close the washblock and proceed to 
Probe Array Scan. 

If attempt to fill the probe array without bubbles is unsuccessful, the array should be filled 
manually with Array Holding Buffer using a micropipette. Excessive washing will result in a loss 
of signal intensity. 

10. Keep the probe arrays at 4°C and in the dark until ready for scanning. 

11. If there are no more samples to hybridize, shut down the fluidics station following the procedure in 
Shutting Down the Fluidics Station. 

 
For proper cleaning and maintenance of the fluidics station, including the 
bleach protocol, refer to the appropriate GeneChip™ Fluidics Station User’s 
Guide for instructions. 
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Using the Fluidics Station 400 

Washing and Staining the Probe Array 
1. In the Fluidics Station dialog box on the workstation, select the correct experiment name in the drop-

down Experiment list. The probe array type will appear automatically. 

2. In the Protocol drop-down list, select the appropriate antibody amplification protocol to control the 
washing and staining of the probe array format being used: Table 6.4 and Table 6.5. 

Table 6.4 
Fluidics Protocols for Fluidics Station 400 

 Mini_prok2v1 FlexMidi_euk2v3 Modified 
FlexMidi_euk2v3 for 
P. aeruginosa Array* 

ProkGE_WS2 

Array 
Format 

169 100 100 49 

Post 
Hyb 
Wash #1 

10 cycles of 2 
mixes/ cycle with 
Wash Buffer A at 
30°C 

10 cycles of 2 mixes/ 
cycle with Wash 
Buffer A at 30°C 

10 cycles of 2 mixes/ 
cycle with Wash 
Buffer A at 25°C 

10 cycles of 2 
mixes/ cycle with 
Wash Buffer A at 
25°C 

Post 
Hyb 
Wash #2 

4 cycles of 15 
mixes/ cycle with 
Wash Buffer B at 
50°C 

6 cycles of 15 mixes/ 
cycle with Wash 
Buffer B at 50°C 

4 cycles of 15 mixes/ 
cycle with Wash 
Buffer B at 50°C 

4 cycles of 15 
mixes/ cycle with 
Wash Buffer B at 
45°C 

1st Stain Stain the probe 
array for 300 
seconds with Stain 
Cocktail 1 at 35°C 

Stain the probe array 
for 300 seconds with 
Stain Cocktail 1 at 
35°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 1 at 
25°C 

Stain the probe 
array for 600 
seconds with Stain 
Cocktail 1 at 25°C. 

Post 
Stain 
Wash 

10 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
30°C 

10 cycles of 4 mixes/ 
cycle with Wash 
Buffer A at 30°C 

10 cycles of 4 mixes/ 
cycle with Wash 
Buffer A at 30°C 

10 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
30°C 

2nd Stain Stain the probe 
array for 300 
seconds with Stain 
Cocktail 2 at 35°C 

Stain the probe array 
for 300 seconds with 
Stain Cocktail 2 at 
35°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 2 at 
25°C 

Stain the probe 
array for 600 
seconds with Stain 
Cocktail 2 at 25°C 

3rd Stain Stain the probe 
array for 300 
seconds with Stain 
Cocktail 3 at 35°C 

Stain the probe array 
for 300 seconds with 
Stain Cocktail 3 at 
35°C 

Stain the probe array 
for 600 seconds with 
Stain Cocktail 3 at 
25°C 

Stain the probe 
array for 600 
seconds with Stain 
Cocktail 3 at 25°C 

Final 
Wash 

15 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
35°C. The holding 
temperature is 
25°C. 

15 cycles of 4 mixes/ 
cycle with Wash 
Buffer A at 35°C. 
The holding 
temperature is 25°C. 

15 cycles of 4 mixes/ 
cycle with Wash 
Buffer A at 30°C. The 
holding temperature is 
25°C. 

15 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
30°. The holding 
temperature is 
25°C. 

Array 
Holding 
Buffer 

N/A - manual 
process 

N/A - manual 
process 

N/A - manual process N/A - manual 
process 

*Refer to Table 6.5 for instructions on how to modify FlexMidi_euk2v3. 
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Table 6.5 
Modification of FlexMidi_euk2v3 for GeneChip™ P. aeruginosa Array 

GeneChip™ P. aeruginosa Genome Array requires a modification to the FlexMidi_euk2v3 protocol. See 
below for details. 
The FlexMidi_euk2v3 fluidics protocol must be modified. Follow the instructions carefully to make the 
modifications. Additionally, it is highly recommended that you save your new P. aeruginosa fluidics 
protocol under a different name to avoid confusion. 

1. Modify and save the fluidics protocol for the assay: 

a. Modify the fluidics protocol by using Tools → Edit Protocol drop-down list and selecting 
FlexMidi_euk2v3 within the Protocol Name window. 

b. Change the following parameters: (Enter the new parameters by highlighting the default values 
and typing in the new values.) 

i. Wash A1 Temperature from 30°C to 25°C; 

ii. Number of Wash B Cycles from 6 to 4; 

iii. Stain Temperature (C) from 35°C to 25°C; 

iv. First Stain Time (seconds) from 300 to 600 seconds; 

v. Second Stain Time (seconds) from 300 to 600 seconds; 

vi. Third Stain Time (seconds) from 300 to 600 seconds; and 

vii. Wash A3 Temperature from 35°C to 30°C. 

c. Save the modified fluidics protocol by highlighting FlexMidi_euk2v3 within the Protocol Name 
window and typing over with an assigned protocol name (e.g., Pae_cDNA). Click Save. The new 
fluidics protocol should be present in the Protocol drop-down list and is used in the subsequent 
steps. 

2. Select the name of the newly modified protocol (e.g., Pae_cDNA) from the Protocol drop-down list 
in the Fluidics Station dialog box. Select Run in the Fluidics Station dialog box to begin the washing 
and staining. Follow the instructions in the LCD window on the fluidics station. 

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
refer to the appropriate User’s Guide for your GeneChip™ Fluidics Station 400. 

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. Follow the 
instructions on the LCD window on the fluidics station. 

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
refer to the Fluidics Station 400 User’s Guide, Fluidics Station 400 Video In-Service CD (Pub. No. 900374), 
or Quick Reference Card (Pub. No. 08-0072). 

4. Insert the appropriate probe array into the designated module of the fluidics station while the 
cartridge lever is in the EJECT position. When finished, verify that the cartridge lever is returned to 
the ENGAGE position. 

5. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station module(s) 
being used. 

6. When the LCD window indicates LOAD 1ST STAIN, place a microcentrifuge tube containing 600 µL 
of Stain Cocktail 1 into the sample holder, making sure that the metal sampling needle is in the tube 
with its tip near the bottom. 

The Fluidics Station dialog box and the LCD window display the status of the washing and staining 
as they progress. 
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7. When the LCD window indicates LOAD 2ND STAIN, replace the microcentrifuge vial containing the 
Stain Cocktail 1 with a microcentrifuge vial containing Stain Cocktail 2 into the sample holder, 
making sure that the metal sampling needle is in the vial with its tip near the bottom. 

 
Do not dispose the vial containing Stain Cocktail 1. Be sure to save the Stain 
Cocktail 1 vial for use in Step 8. 

8. When the LCD window indicates LOAD 3RD STAIN, replace the microcentrifuge vial containing 
Stain Cocktail 2 with the saved microcentrifuge vial containing 600 µL of Stain Cocktail 1 (retained 
from the previous step) into the sample holder. Verify that the metal sampling needle is in the vial 
with its tip near the bottom. 

The Fluidics Station dialog box and the LCD window display the status of the washing and staining 
as they progress. When the wash is complete, the LCD window displays the message EJECT 
CARTRIDGE. 

9. Remove microcentrifuge vial containing stain and replace with an empty microcentrifuge tube. 

10. Remove the probe arrays from the fluidics station modules by first moving the cartridge lever to the 
EJECT position. 

11. Fill the probe array manually with Array Holding Buffer as follows: 

a. Vent one of the septa with a clean pipette tip. Drain the Wash Buffer A from the remaining 
septum of the probe array using a micropipettor. Refill the array completely with Array Holding 
Buffer. Refer to Table 6.1 for the fill volume specific to the array type used. 

b. Inspect the array and ensure that no bubbles are present. The probe array is ready to be scanned 
on the GeneChip™ Scanner 3000 or the GeneArray™ Scanner. 

c. Pull up on the cartridge lever to engage wash board and proceed to Probe Array Scan. 

If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark until ready for 
scanning. 

If there are no more samples to hybridize, shut down the fluidics station following the procedure 
outlined in the section, Shutting Down the Fluidics Station. 

 
For proper cleaning and maintenance of the fluidics station, including the bleach 
protocol, refer to the appropriate GeneChip™ Fluidics Station User’s Guide for 
instructions. 
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Probe Array Scan 
The scanner is also controlled by Microarray Suite or GCOS. The probe array is scanned after the wash 
protocols are complete. Make sure the laser is warmed up prior to scanning by turning it on at least 15 
minutes before use if you are using the Agilent GeneArray™ Scanner, or 10 minutes if you are using the 
GeneChip™ Scanner 3000. If the probe array was stored at 4°C, warm to room temperature before 
scanning. Refer to the Microarray Suite or GCOS online help and the appropriate scanner user’s manual for 
more information on scanning. 

 
The scanner uses a laser and is equipped with a safety interlock system. 
Defeating the interlock system may result in exposure to hazardous laser 
light. 

 

 
You must have read and be familiar with the operation of the scanner before 
attempting to scan a probe array. Refer to the Microarray Suite User’s Guide 
(P/N 08-0081), GeneChip™ Operating Software User’s Guide (P/N 701439), or to 
the GeneChip™ Scanner 3000 Quick Reference Card (P/N 08-0075). 

Handling the GeneChip™ Probe Array 
Before you scan the probe array, follow the directions in this section on handling the probe array. If 
necessary, clean the glass surface of the probe array with a non-abrasive towel or tissue before scanning. Do 
not use alcohol to clean glass. 

Before scanning the probe array cartridge, follow this procedure to apply Tough-Spots™ to the probe array 
cartridge to prevent the leaking of fluids from the cartridge during scanning. 

 
Apply the spots just before scanning. 

1. On the back of the probe array cartridge, clean excess fluid from around septa. 

2. Carefully apply one Tough-Spot to each of the two septa. Press to ensure that the spots remain flat. If 
the Tough-Spots do not apply smoothly; that is, if you observe bumps, bubbles, tears or curled edges, 
do not attempt to smooth out the spot. Remove the spot and apply a new spot. See Figure 6.1. 

Figure 6.1 Applying Tough-Spots™ to the Probe Array Cartridge 
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3. Insert the cartridge into the scanner and test the autofocus to ensure that the Tough-Spots do not 
interfere with the focus. If you observe a focus error message, remove the spot and apply a new spot. 
Ensure that the spots lie flat. 

Scanning the Probe Array 
1. Select Run → Scanner from the menu bar. Alternatively, click the Start Scan icon in the tool bar. 

The Scanner dialog box appears with a drop-down list of experiments that have not been run. 

2. Select the experiment name that corresponds to the probe array to be scanned. 

A previously run experiment can also be selected by using the Include Scanned Experiments option 
box. After selecting this option, previously scanned experiments appear in the drop-down list. 

3. By default, for the GeneArray™ Scanner only, after selecting the experiment the number [2] is 
displayed in the Number of Scans box to perform the recommended 2X image scan. For the 
GeneChip™ Scanner 3000, only one scan is required. 

4. Once the experiment has been selected, click the Start button. 

A dialog box prompts you to load a sample into the scanner. 

5. If you are using the GeneArray™ Scanner, click the Options button to check for the correct pixel 
value and wavelength of the laser beam. 

• Pixel value = 3 µm 

• Wavelength = 570 nm 

If you are using the GeneChip™ Scanner 3000, pixel resolution and wavelength are preset and 
cannot be changed. 

6. Open the sample door on the scanner and insert the probe array into the holder. Do not force the 
probe array into the holder. Close the sample door of the scanner. If you are using the GeneChip™ 
Scanner 3000, do not attempt to close the door by hand. The door closes automatically through the 
User Interface when start scan is selected or the scanner goes into stand-by mode. 

7. Click OK in the Start Scanner dialog box. 

The scanner begins scanning the probe array and acquiring data. When Scan in Progress is selected 
from the View menu, the probe array image appears on the screen as the scan progresses. 

Shutting Down the Fluidics Station 
1. After removing a probe array from the probe array holder, the LCD window displays the message 

ENGAGE WASHBLOCK. 

2. If you are using the FS-400, latch the probe array holder by gently pushing up until a light click is 
heard. Engage the washblock by firmly pushing up on the cartridge lever to the ENGAGE position. 

If you are using the FS-450, gently lift up the cartridge lever to engage, or close, the washblock. 

The fluidics station automatically performs a Cleanout procedure. The LCD window indicates the 
progress of the Cleanout procedure. 

3. When the fluidics station LCD window indicates REMOVE VIALS, the Cleanout procedure is 
complete. 

4. Remove the sample microcentrifuge vial(s) from the sample holder(s). 

5. If no other hybridizations are to be performed, place wash lines into a bottle filled with deionized 
water. 

6. Select Shutdown or Shutdown_450 for all modules from the drop-down Protocol list in the Fluidics 
Station dialog box. Click the Run button for all modules. 
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The Shutdown protocol is critical to instrument reliability. Refer to the appropriate Fluidics Station 
User’s Guide for more information. 

7. After Shutdown protocol is complete, flip the ON/OFF switch of the fluidics station to the OFF 
position. 

 
To maintain the cleanliness of the fluidics station and obtain the highest 
quality image and data possible, a weekly bleach protocol and a monthly 
decontamination protocol are highly recommended. Refer to the appropriate 
GeneChip™ Fluidics Station User’s Guide for further detail. 

Customizing the Protocol 
There may be times when the fluidics protocols need to be modified. Modification of protocols must be 
done before downloading the protocol to the fluidics station. Protocol changes will not affect runs in 
progress. For more specific instructions, refer to the Microarray Suite/ GCOS online help. 

1. Select Tools → Edit Protocol from the menu bar. 

2. In the Edit Protocol dialog box under Protocol Name, click the arrow to open a list of protocols. Click 
the protocol to be changed. 

The name of the protocol is displayed in the Protocol Name text box. The conditions for that protocol 
are displayed on the right side of the Edit Protocol dialog box. 

3. Select the items to be changed and input the new parameters as needed, keeping parameters within 
the ranges shown below in Table 6.6. 

Table 6.6 
Valid Ranges for Wash/Stain Parameters 

Parameter Valid Range 

Wash Temperature for A1, B, A2, or A3 (°C) 15 to 50 

Number of Wash Cycles for A1, B, A2, or A3 0 to 99 

Mixes / Wash Cycle for A1, B, A2, or A3  1 to 99 

Stain Time (seconds) 0 to 86,399 

Stain Temperature (°C)  15 to 50 

Holding Temperature (°C)  15 to 50 

• Wash A1 corresponds to Post Hyb Wash #1 in Table 6.2 and Table 6.4. 
• Wash B corresponds to Post Hyb Wash #2 in Table 6.2 and Table 6.4. 
• Wash A2 corresponds to Post Stain Wash in Table 6.2 and Table 6.4. 
• Wash A3 corresponds to Final Wash in Table 6.2 and Table 6.4. 

Enter 0 (zero) for hybridization time if hybridization step is not required. Likewise, enter 0 (zero) for 
the stain time if staining is not required. Enter 0 (zero) for the number of wash cycles if a wash step is 
not required. 

4. To return to the default values for the protocol selected, click the Defaults button. 

5. Once all the protocol conditions are modified as desired, change the name of the edited protocol in 
the Protocol Name box. 

 
If the protocol is saved without entering a new “Protocol Name,” the original 
protocol parameters will be overwritten. 

6. Click Save, then close the dialog box. 
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Appendix A Alternative Protocols for One-Cycle cDNA 
Synthesis 

Reagents and Materials Required 
The following reagents and materials are recommendations and have been tested and evaluated by our 
scientists. Information and part numbers listed are based on U.S. catalog information. For supplier 
information, refer to the Supplier Reference List in Appendix F of this manual. 

• GeneChip™ T7-Oligo(dT) Promoter Primer Kit, 

5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´ 

50 µM, HPLC purified: P/N 900375 

• SuperScript™ II:, P/N 18064-014 or SuperScript Choice System for cDNA Synthesis: P/N 18090-019. 

 

SuperScript Choice System contains, in addition to SuperScript II Reverse 
Transcriptase, other reagents for cDNA synthesis. However, not all components 
provided in the Choice System are used in the GeneChip™ cDNA synthesis 
protocol. 

• E. coli DNA Ligase: P/N 18052-019 

• E. coli DNA Polymerase I: P/N 18010-025 

• E. coli RNase H: P/N 18021-071 

• T4 DNA Polymerase: P/N 18005-025 

• 5X Second-strand buffer:, P/N 10812-014 

• 10 mM dNTP: P/N 18427-013 

• 0.5M EDTA 

Alternative Protocol for One-Cycle cDNA Synthesis from Total 
RNA 
This protocol is a supplement to instructions provided in the Invitrogen Life Technologies SuperScript 
Choice system. Note the following before proceeding: 

• Read all information and instructions that come with reagents and kits. 

• Use the GeneChip™ T7-Oligo(dT) Promoter Primer Kit1 for priming first-strand cDNA synthesis in 
place of the oligo(dT) or random primers provided with the SuperScript Choice kit. The GeneChip™ 
T7-Oligo(dT) Promoter Primer Kit provides high-quality HPLC-purified T7-Oligo(dT) Primer, which 
is essential for this reaction. 

T7-Oligo(dT) Primer 
5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´ 

1 Users who do not purchase the GeneChip™ T7-Oligo(dT) Promoter Primer Kit may be required to obtain a license under U.S. 
Patent Nos. 5,716,785, 5,891,636, 6,291,170, and 5,545,522 or to purchase another licensed kit. 
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Step 1: First-Strand cDNA Synthesis 
Starting material: High-quality total RNA (5.0 µg to 20.0 µg) 

 

When using the GeneChip™ Sample Cleanup Module for the cDNA and IVT cRNA 
cleanup steps, there is a potential risk of overloading the columns if greater 
than the recommended amount of starting material is used. 

After purification, the RNA concentration is determined by absorbance at 260 nm on a spectrophotometer 
(one absorbance unit = 40 µg/mL RNA). The A260/A280 ratio should be approximately 2.0, with ranges 
between 1.9 to 2.1 considered acceptable. We recommend checking the quality of the RNA by running it on 
an agarose gel prior to starting the assay. The rRNA bands should be clear without any obvious smearing 
patterns from degradation. 

Before starting cDNA synthesis, the correct volumes of DEPC-treated H2O and Reverse Transcriptase (RT) 
must be determined. These volumes will depend on both the concentration and total volume of RNA that is 
being added to the reaction. 

 

 
Use Table A.1 and Table A.2 for variable component calculations. Determine 
the volumes of RNA and SuperScript II RT required in Table A.1, then 
calculate the amount of DEPC-treated H2O needed in Step 1 Table A.2 to 
bring the final First-Strand Synthesis volume to 20 µL. 

Table A.1 Reverse Transcriptase Volumes for First-Strand cDNA Synthesis Reaction 

Total RNA (µg) SuperScript II RT (µL), 200 U/µL 

5.0 to 8.0 1.0 

8.1 to 16.0 2.0 

16.1 to 20.0 3.0 

 

 
The combined volume of RNA, DEPC-treated H2O and SuperScript II RT should 
not exceed 11 µL as indicated in Table A.2. 
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Table A.2 First-Strand cDNA Synthesis Components 

 Reagents in Reaction Volume Final Dilution 
or Amount in Reaction 

1: Primer Hybridization 
Incubate at 70°C for 10 
minutes. Quick spin and  

DEPC-treated H2O (variable) 
T7-Oligo(dT) Primer, 50 µM 
RNA (variable) 

for final 
reaction 

volume of 
20 µL 
2 µL 

5.0 to 20 µg 

100 pmol 
5.0 to 20 µg 

2: Temperature Adjustment 
Add to the above tube and 
mix well Incubate at 42°C 
for 2 minutes 

5X First-Strand cDNA buffer 
0.1M DTT 
10 mM dNTP mix 

4 µL 
2 µL 
1 µL 

1X 
10 mM DTT 
500 µM each 

3: First-Strand Synthesis 
Add to the above tube and 
mix well Incubate at 42°C 
for 1 hr 

SuperScript II RT (variable) 
(200 U/µL) 

See Table A.1 200U to 600U 

Total Volume 20 µL  

 

Step 2: Second-Strand cDNA Synthesis 
1. Place First-Strand reactions on ice. Centrifuge briefly to bring down condensation on sides of tube. 

2. Add to the First-Strand synthesis tube the reagents listed in the following Second-Strand Final 
Reaction Composition Table (Table A.3). 

Table A.3 
Second-Strand Final Reaction Composition 

Component Volume Final Dilution or Amount in 
Reaction 

DEPC-treated water 91 µL  

5X Second-Strand Reaction Buffer 30 µL 1X 

10 mM dNTP mix 3 µL 200 µM each 

10 U/µL E. coli DNA Ligase 1 µL 10U 

10 U/µL E. coli DNA Polymerase I 4 µL 40U 

2 U/µL E. coli RNase H 1 µL 2U 

Total Volume 150 µL  

3. Gently tap tube to mix. Then, briefly spin in a microcentrifuge to remove condensation and incubate 
at 16°C for 2 hours in a cooling waterbath. 

4. Add 2 µL [10U] T4 DNA Polymerase. 

5. Return to 16°C for 5 minutes. 

 
The above incubations have been changed from the SuperScript protocols and 
are done at 42°C. 
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6. Add 10 µL 0.5M EDTA. 

7. Proceed to cleanup procedure for cDNA, Cleanup of Double-Stranded cDNA for Both the One-Cycle and 
Two-Cycle Target Labeling Assays, or store at –20°C for later use. 

Alternative Protocol for One-Cycle cDNA Synthesis from 
Purified Poly-A mRNA 
This protocol is a supplement to instructions provided in the Invitrogen Life Technologies SuperScript 
Choice system. Note the following before proceeding: 

• Read all information and instructions that come with reagents and kits. 

• Use the GeneChip™ T7-Oligo(dT) Promoter Primer Kit1 for priming first-strand cDNA synthesis in 
place of the oligo(dT) or random primers provided with the SuperScript Choice kit. The GeneChip™ 
T7-Oligo(dT) Promoter Primer Kit provides high-quality HPLC-purified T7-Oligo(dT) Primer, which 
is essential for this reaction. 

• It is recommended that each step of this protocol is checked by gel electrophoresis. 
1 Users who do not purchase the GeneChip™ T7-Oligo(dT) Promoter Primer Kit may be required to obtain a license under U.S. 
Patent Nos. 5,716,785, 5,891,636, 6,291,170, and 5,545,522 or to purchase another licensed kit. 

T7-Oligo(dT) Primer 
5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´ 

Step 1: First-Strand cDNA Synthesis 
Starting material: High-quality poly-A mRNA (0.2 µg to 2.0 µg). 

 

When using the GeneChip™ Sample Cleanup Module for the cDNA and IVT cRNA 
cleanup steps, there is a potential risk of overloading the columns if greater 
than the recommended amount of starting material is used. 

Before starting cDNA synthesis, the correct volumes of DEPC-treated H2O and Reverse Transcriptase (RT) 
must be determined. These volumes will depend on both the concentration and total volume of mRNA that 
is being added to the reaction. For every µg of mRNA, you will need to add 1 µL of SuperScript II RT (200 
U/µL). For mRNA quantity ≤1 µg, use 1 µL of SuperScript II RT. Synthesis reactions should be done in a 
polypropylene tube (RNase-free). 

 

 
Use Table A.4 for variable component calculations. Determine volumes of 
mRNA and SuperScript II RT required, and then calculate the amount of 
DEPC-treated H2O needed in the Primer Hybridization Mix step to bring the 
final First-Strand Synthesis reaction volume to 20 µL. 
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Table A.4 First-Strand cDNA Synthesis Components 

 Reagents in Reaction Volume Final Dilution 
or Amount in Reaction 

1: Primer Hybridization 
Incubate at 70°C for 10  
minutes 
Quick spin and put on ice 

DEPC-treated H2O 
(variable) 

for final reaction 
volume of 20 µL 

 

T7-Oligo(dT) Primer, 50 µM 
mRNA (variable) 

2 µL 
0.2 to 2 µg 

100 pmol 
0.2 to 2 µg 

2: Temperature Adjustment 
Add to the above tube and 
mix well 
Incubate at 37°C for 2 
minutes 

5X First-Strand cDNA buffer 
0.1M DTT 

10 mM dNTP mix 

4 µL 
2 µL 
1 µL 

1X 
10 mM 

500 µM each 

3: First-Strand Synthesis 
Add to the above tube and 
mix well 
Incubate at 37°C for 1 hour 

SuperScript II RT 
(variable) (200 U/µL) 

1 µL per µg mRNA 200U to 400U 

Total Volume 20 µL 

Step 2: Second-Strand cDNA Synthesis  
1. Place First-Strand reactions on ice. Centrifuge briefly to bring down condensation on sides of tube. 

2. Add to the First-Strand synthesis tube the reagents listed in the following Second-Strand Final 
Reaction Composition Table (Table A.5). 

Table A.5 Second-Strand Final Reaction Composition 

Component Volume Final Dilution or Amount 
in Reaction 

DEPC-treated water 91 µL  

5X Second-Strand Reaction 
Buffer 

30 µL 1X 

10 mM dNTP mix 3 µL 200 µM each 

10 U/µL E. coli DNA Ligase 1 µL 10U 

10 U/µL E. coli DNA Polymerase I 4 µL 40U 

2 U/µL E. coli RNase H 1 µL 2U 

Total Volume 150 µL  

3. Gently tap tube to mix. Then, briefly spin in a microcentrifuge to remove condensation and incubate 
at 16°C for 2 hours in a cooling waterbath. 

4. Add 2 µL [10 U] T4 DNA Polymerase. 
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5. Return to 16°C for 5 minutes. 

6. Add 10 µL 0.5M EDTA. 

7. Proceed to cleanup procedure for cDNA, Cleanup of Double-Stranded cDNA for Both the One-Cycle and 
Two-Cycle Target Labeling Assays, or store at –20°C for later use. 
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Appendix B Alternative Protocol for Eukaryotic Target 
Hybridization 
This Appendix Contains: 

• Introduction and objectives for information provided in this Appendix. 

• Detailed steps for preparing the eukaryotic hybridization mix containing labeled target and control 
cRNA. 

• Instructions for hybridizing the target mix to a eukaryotic GeneChip™ probe array. 

After completing the procedures described in this chapter, the hybridized probe array is ready for washing, 
staining, and scanning, as detailed in the GeneChip™ Expression Wash, Stain and Scan User Manual, Pub. No. 
MAN0018114 (formerly Pub. No. 702731). 

Introduction and Objectives 
We offer a complete set of GeneChip™ reagents developed specifically for use with GeneChip™ 3’ 
eukaryotic arrays in cartridge format and GeneChip™ prokaryotic arrays in cartridge format. GeneChip™ 
reagent kits include the One- and Two-Cycle cDNA Synthesis Kits, IVT Labeling Kits, Sample Cleanup 
Modules, and Hybridization, Wash, and Stain Kits. For best results, it is highly recommended that all 
GeneChip™ reagents are used for target preparation, hybridization, wash, and staining when using 
GeneChip™ arrays. 

The information and protocols described in this Appendix have been provided in previous revisions of the 
GeneChip™ Expression Analysis Technical Manual describing hybridization, wash, and staining procedures 
for GeneChip™ 3’ eukaryotic arrays in cartridge format. These protocols should be closely followed when 
the GeneChip™ Hybridization, Wash, and Stain Kit is not used. 

Reagents and Materials Required 
The following reagents and materials are recommendations and have been tested and evaluated by our 
scientists. Information and part numbers listed are based on U.S. catalog information. For supplier 
information, refer to the Supplier Reference List in Appendix F of this manual. 

• Water, Molecular Biology Grade: Cambrex, P/N 51200 

• Bovine Serum Albumin (BSA) solution (50 mg/mL): P/N 15561-020 

• Herring Sperm DNA: Promega Corporation, P/N D1811 

• GeneChip™ Eukaryotic Hybridization Control Kit: P/N 900454 (30 reactions) or P/N 900457 (150 
reactions), contains 

- Control cRNA and Control Oligo B2 

- Control Oligo B2, 3 nM: P/N 900301 (can be ordered separately) 

• 5 M NaCl, RNase-free, DNase-free: P/N 9760G 

• MES hydrate SigmaUltra: Sigma-Aldrich, P/N M5287 

• MES Sodium Salt: Sigma-Aldrich, P/N M5057 

• EDTA Disodium Salt, 0.5 M solution (100 mL): Sigma-Aldrich, P/N E7889 

• DMSO: Sigma-Aldrich, P/N D5879 

• Surfact-Amps 20 (Tween-20), 10%: P/N 28320 
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Miscellaneous Supplies 
• Hybridization Oven 640: P/N 800138 (110V) or 800139 (220V) 

• Sterile, RNase-free, microcentrifuge vials, 1.5 mL: USA Scientific, P/N 1415-2600 (or equivalent) 

• Micropipettors, (P-2, P-20, P-200, P-1000): Rainin Pipetman (or equivalent) 

• Sterile-barrier pipette tips and non-barrier pipette tips 

• Heatblock 

Reagent Preparation 

12X MES Stock Buffer 
(1.22 M MES, 0.89M [Na+]) 

For 1,000 mL: 

64.61 g of MES hydrate 

193.3 g of MES Sodium Salt 

800 mL of Molecular Biology Grade water Mix and adjust volume to 1,000 mL. 

The pH should be between 6.5 and 6.7. Filter through a 0.2 µm filter. 

 
Do not autoclave. Store at 2°C to 8°C, and shield from light. Discard solution 
if yellow. 

2X Hybridization Buffer 
(Final 1X concentration is 100 mM MES, 1 M [Na+], 20 mM EDTA, 0.01% Tween-20) 

For 50 mL: 

8.3 mL of 12X MES Stock Buffer 

17.7 mL of 5 M NaCl 

4.0 mL of 0.5 M EDTA 

0.1 mL of 10% Tween-20 

19.9 mL of water 

Store at 2°C to 8°C, and shield from light 
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Eukaryotic Target Hybridization 
Refer to Table B.1 for the necessary amount of cRNA required for appropriate probe array format. These 
recipes take into account that it is necessary to make extra hybridization cocktail due to a small loss of 
volume (10 to 20 µL) during each hybridization. 

1. Mix the following for each target, scaling up volumes for hybridization to multiple probe arrays. 

 
If using the GeneChip™ IVT Labeling Kit to prepare the target, a final 
concentration of 10% DMSO needs to be added in the hybridization cocktail 
for optimal results. 

Table B.1 Hybridization Cocktail for Single Probe Array* 

Component 49 Format 
(Standard) / 64 
Format Array  

100 Format 
(Midi) Array 

169 Format 
(Mini) Array / 
400 Format 
(Micro) Array 

Final Dilution 

Fragmented cRNA† 15 µg 10 µg 5 µg 0.05 µg/µL 

Control 
Oligonucleotide 
B2 (3 nM) 

5 µL 3.3 µL 1.7 µL 50 pM 

20X Eukaryotic 
Hybridization Controls 
(bioB, bioC, bioD, cre) 

15 µL 10 µL 5 µL 1.5, 5, 25, and 
100 pM 
respectively 

2X Hybridization 
Buffer 

150 µL 100 µL 50 µL 1X 

Herring Sperm DNA 
(10 mg/mL) 

3 µL 2 µL 1 µL 0.1 mg/mL 

BSA 
(50 mg/mL) 

3 µL 2 µL 1 µL 0.5 mg/mL 

DMSO‡ 30 µL 20 µL 10 µL 10% 

H2O to final volume of 
300 µL 

to final volume 
of 200 µL 

to final volume 
of 100 µL 

Total Volume 300 µL 200 µL 100 µL 

*Refer to specific probe array package insert for information on array format. 
†See Chapter 2, for amount of adjusted fragmented cRNA to use when starting from total RNA. 
‡Note that the addition of DMSO is different from previous recommendations. Follow this protocol for best results on arrays when using 

the GeneChip™ IVT Labeling Kit. 

 
It is important to allow the arrays to equilibrate to room temperature 
completely. Specifically, if the rubber septa are not equilibrated to room 
temperature, they may be prone to cracking, which can lead to leaks. 

2. Equilibrate probe array to room temperature immediately before use. 

 

It is important to allow the arrays to equilibrate to room temperature completely. 
Specifically, if the rubber septa are not equilibrated to room temperature, they may 
be prone to cracking, which can lead to leaks. 

3. Heat the hybridization cocktail to 99°C for 5 minutes in a heat block. 



 

GeneChip™ Expression Analysis Technical ManualUser Guide  75 

4. Meanwhile, wet the array by filling it through one of the septa (see Figure B.1 for location of the 
probe array septa) with appropriate volume of 1X Hybridization Buffer using a micropipettor and 
appropriate tips Table B.2. 

 
It is necessary to use two pipette tips when filling the probe array cartridge: 
one for filling and the second to allow venting of air from the hybridization 
chamber. 

5. Incubate the probe array filled with 1X Hybridization Buffer at 45°C for 10 minutes with rotation. 

Table B.2 Probe Array Cartridge Volumes 

Array Hybridization Volume Total Fill Volume 

49 Format (Standard) 200 µL 250 µL 

64 Format 200 µL 250 µL 

100 Format (Midi) 130 µL 160 µL 

169 Format (Mini) 80 µL 100 µL 

400 Format (Micro) 80 µL 100 µL 

6. Transfer the hybridization cocktail that has been heated at 99°C, in step 3, to a 45°C heat block for 5 
minutes. 

7. Spin hybridization cocktail(s) at maximum speed in a microcentrifuge for 5 minutes to remove any 
insoluble material from the hybridization mixture. 

8. Remove the buffer solution from the probe array cartridge and fill with appropriate volume Table 
B.2 of the clarified hybridization cocktail, avoiding any insoluble matter at the bottom of the tube. 

9. Place probe array into the Hybridization Oven, set to 45°C. Avoid stress to the motor; load probe 
arrays in a balanced configuration around the axis. Rotate at 60 rpm. 

10. Hybridize for 16 hours. 

During the latter part of the 16-hour hybridization, proceed to the GeneChip™ Expression Wash, Stain 
and Scan User Manual, Pub. No. 702731, to prepare reagents required immediately after completion of 
hybridization. 

Figure B.1 GeneChip™ Probe Array 
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Appendix C Alternative Protocol for Prokaryotic Target 
Hybridization 

Appendix Contents 

This Appendix Contains: 

• Introduction and objectives for information provided in this Appendix. 

• Steps for preparing the hybridization mix, and instructions for hybridizing the target mix to the 
GeneChip™ P. aeruginosa Genome Array and GeneChip™ E. coli arrays. The hybridized probe array 
is then ready for washing, staining, and scanning as detailed in Appendix D. 

Introduction and Objectives 
We offer a complete set of GeneChip™ reagents developed specifically for use with GeneChip™ 3’ 
eukaryotic arrays in cartridge format and GeneChip™ prokaryotic arrays in cartridge format. GeneChip™ 
reagent kits include the One- and Two-Cycle cDNA Synthesis Kits, IVT Labeling Kits, Sample Cleanup 
Modules, and Hybridization, Wash, and Stain Kits. For best results, it is highly recommended that all 
GeneChip™ reagents are used for target preparation, hybridization, wash, and staining when using 
GeneChip™ arrays. 

The information and protocols described in this Appendix have been provided in previous revisions of the 
GeneChip™ Expression Analysis Technical Manual describing hybridization, wash, and staining procedures 
for GeneChip™ prokaryotic arrays in cartridge format. These protocols should be closely followed when 
the GeneChip™ Hybridization, Wash, and Stain Kit is not used. 

Reagents and Materials Required 
The following reagents and materials are recommendations and have been tested and evaluated by our 
scientists. Information and part numbers listed are based on U.S. catalog information. For supplier 
information, refer to the Supplier Reference List in Appendix F of this manual. 

• Water, Molecular Biology Grade: Cambrex, P/N 51200 

• Bovine Serum Albumin (BSA) solution, 50 mg/mL: P/N 15561-020 

• Herring Sperm DNA: Promega Corporation, P/N D1811 

• Control Oligo B2, 3 nM: P/N 900301 (can be ordered separately) 

• NaCl, 5M, RNase-free, DNase-free: P/N 9760G 

• MES hydrate SigmaUltra: Sigma-Aldrich, P/N M5287 

• MES Sodium Salt: Sigma-Aldrich, P/N M5057 

• EDTA Disodium Salt, 0.5M solution (100 mL): Sigma-Aldrich, P/N E7889 

Miscellaneous Reagents 
• 100% DMSO: Sigma-Aldrich, P/N D2650 

• Surfact-Amps 20 (Tween-20), 10%: P/N 28320 
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Miscellaneous Supplies 
• Hybridization Oven 640: P/N 800138 (110V) or 800139 (220V) 

• Sterile, RNase-free, microcentrifuge vials, 1.5 mL: USA Scientific ™, P/N 1415-2600 (or equivalent) 

• Micropipettors, (P-2, P-20, P-200, P-1000): Rainin ™ Pipetman ™ (or equivalent) 

• Sterile-barrier pipette tips and non-barrier pipette tips 

Reagent Preparation 
12X MES Stock Buffer 
(1.22M MES, 0.89 M [Na+]) 

For 1,000 mL: 

64.61 g of MES hydrate 

193.3 g of MES Sodium Salt 

800 mL of Molecular Biology Grade water Mix and adjust volume to 1,000 mL. 

The pH should be between 6.5 and 6.7. Filter through a 0.2 µm filter. 

 
Do not autoclave, store at 2°C to 8°C, and shield from light. Discard solution if 
yellow. 

2X Hybridization Buffer (50 mL) 
(Final 1X concentration is 100mM MES, 1 M [Na+], 20 mM EDTA, 0.01% Tween-20) 

For 50 mL: 

8.3 mL of 12X MES Stock Buffer 

17.7 mL of 5 M NaCl 

4.0 mL of 0.5 M EDTA 

0.1 mL of 10% Tween-20 

19.9 mL of water 

Store at 2°C to 8°C, and shield from light. 
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Prokaryotic Target Hybridization 
After determining that the fragmented cDNA is labeled with biotin, prepare the hybridization solution mix. 
The minimum amount of cDNA product required for target hybridization is 1 µg. The solution is stable for 
approximately 6 to 8 hours at 4°C. The following protocol can be used for freshly prepared or frozen 
hybridization cocktail. Re-use of prokaryotic sample has not been thoroughly tested and, therefore, is not 
recommended. 

1. Prepare the following hybridization solution mix. 

Table C.1 
Hybridization Cocktail for Single Probe Array* 

Component 49 Format 
(Standard) 

100 Format (Midi) 169 Format 
(Mini) 

Final Dilution or 
Amount 

Fragmented and 
Labeled cDNA 

Up to 50 µL Up to 50 µL 25 µL 0.5 – 7.0 µg 

Control Oligonucleotide 
B2 (3 nM) 

3.3 µL 2.2 µL 1.3 µL 50 pM 

2X Hybridization Buffer 100 µL 65 µL 40 µL 1X 

100% DMSO – 10.2 µL 6.2 µL 7.8% (or 0%) 

10 mg/mL Herring 
Sperm DNA 

2.0 µL 1.3 µL 0.8 µL 0.1 mg/mL 

50 mg/mL BSA 2.0 µL 1.3 µL 0.8 µL 0.5 mg/mL 

Molecular Biology 
Grade Water 

42.7 µL – 5.9 µL  

Total Volume 200 µL 130 µL 80 µL  

*Refer to specific probe array package insert for information on array format. 

2. Equilibrate probe array to room temperature immediately before use. 

 
It is important to allow the arrays to normalize to room temperature 
completely. Specifically, if the rubber septa are not equilibrated to room 
temperature, they may be prone to cracking, which leads to leaks. 

3. Add the indicated amount of hybridization solution mix to the probe array. Refer to specific probe 
array package insert for information on array format. 

 

It is necessary to use two pipette tips when filling the probe array cartridge: 
one for filling and the second to allow venting of air from the hybridization 
chamber. 

4. Place the probe array in the hybridization oven set at the temperatures indicated below. 

• P. aeruginosa array 50°C 

• E. coli Antisense arrays 45°C 

  

 

The hybridization temperature of 50°C is higher than that used for other 
expression assays. The increased hybridization temperature is required due to 
the high GC content of P. aeruginosa. 
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5. Avoid stress to the motor; load probe arrays in a balanced configuration around axis. Rotate at 60 
rpm. 

6. Hybridize for 16 hours. 

During the latter part of the 16-hour hybridization, proceed to Appendix D, Alternative Protocol for 
Prokaryotic Arrays: Washing, Staining and Scanning to prepare reagents required immediately after 
completion of hybridization. 
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Appendix D Alternative Protocol for Prokaryotic 
Arrays:Washing, Staining and Scanning 
This Appendix Contains: 

• Introduction and objectives for information provided in this Appendix. 

• Instructions for using the Fluidics Station 400 or 450/250 to automate the washing and staining of 
GeneChip™ P. aeruginosa and GeneChip™ E. coli arrays. 

• Instructions for scanning probe arrays using the GeneArray™ Scanner or the GeneChip™ Scanner 
3000. 

After completing the procedures described in this chapter, the scanned probe array image (.dat file) is 
ready for analysis, as explained in the enclosed GeneChip™ Expression Analysis: Data Analysis Fundamentals 
booklet (Pub. No. 701190). 

Introduction and Objectives 
We offer a complete set of GeneChip™ reagents developed specifically for use with GeneChip™ 3’ 
eukaryotic arrays in cartridge format and GeneChip™ prokaryotic arrays in cartridge format. GeneChip™ 
reagent kits include the One- and Two-Cycle cDNA Synthesis Kits, IVT Labeling Kits, Sample Cleanup 
Modules, and Hybridization, Wash, and Stain Kits. For best results, it is highly recommended that all 
GeneChip™ reagents are used for target preparation, hybridization, wash, and staining when using 
GeneChip™ arrays. 

The information and protocols described in this Appendix have been provided in previous revisions of the 
GeneChip™ Expression Analysis Technical Manual describing hybridization, wash, and staining procedures 
for GeneChip™ prokaryotic arrays in cartridge format. These protocols should be closely followed when 
the GeneChip™ Hybridization, Wash, and Stain Kit is not used. 

Reagents and Materials Required 
The following reagents and materials are recommendations and have been tested and evaluated by our 
scientists. Information and part numbers listed are based on U.S. catalog information. For supplier 
information, refer to the Supplier Reference List in Appendix F of this manual. 

• Water, Molecular Biology Grade: Cambrex, P/N 51200 

• Nuclease-free Water: P/N 9930 

• Bovine Serum Albumin (BSA) solution, 50 mg/mL: P/N 15561-020 

• R-Phycoerythrin Streptavidin:, P/N S-866 

• NaCl, 5M, RNase-free, DNase-free: P/N 9760G 

• PBS, pH 7.2: P/N 20012-027 

• 20X SSPE (3 M NaCl, 0.2M NaH2PO4, 0.02 M EDTA): Cambrex, P/N 51214 

• Goat IgG, Reagent Grade: Sigma-Aldrich, P/N I 5256 

• Anti-streptavidin antibody (goat), biotinylated: Vector Laboratories, P/N BA-0500 

• Surfact-Amps 20 (Tween-20), 10%: P/N 28320 

• Bleach (5.25% Sodium Hypochlorite): VWR Scientific, P/N 37001-060 (or equivalent) 

• ImmunoPure Streptavidin: P/N 21125 
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Miscellaneous Supplies 
• Sterile, RNase-free, microcentrifuge vials, 1.5 mL: USA Scientific, P/N 1415-2600 (or equivalent) 

• Micropipettors, (P-2, P-20, P-200, P-1000): Rainin Pipetman (or equivalent) 

• Sterile-barrier pipette tips and non-barrier pipette tips 

• Tygon Tubing, 0.04″ inner diameter: Cole-Parmer, P/N H-06418- 04 

• Tough-Spots, Label Dots: USA Scientific, P/N 9185-0000 

Reagent Preparation 

Wash Buffer A: Non-Stringent Wash Buffer 
(6X SSPE, 0.01% Tween-20) 

For 1,000 mL: 

300 mL of 20X SSPE 

1.0 mL of 10% Tween-20 

699 mL of water 

Filter through a 0.2 µm filter. 

Store at room temperature. 

Wash Buffer B: Stringent Wash Buffer 
(100 mM MES, 0.1 M [Na+], 0.01% Tween-20) 

For 1,000 mL: 

83.3 mL of 12 X MES Stock Buffer (see Appendix C for reagent preparation) mL of 5M NaCl 

1.0 mL of 10% Tween-20 

910.5 mL of water 

Filter through a 0.2 µm filter 

Store at 2°C to 8°C and shield from light. 

2X Stain Buffer 
(final 1X concentration: 100 mM MES, 1 M [Na+], 0.05% Tween-20) 

For 250 mL: 

41.7 mL of 12X MES Stock Buffer (see Appendix C) 

92.5 mL of 5M NaCl 

2.5 mL of 10% Tween-20 

113.3 mL of water 

Filter through a 0.2 µm filter. 

Store at 2°C to 8°C and shield from light. 
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10 mg/mL Goat IgG Stock 
Resuspend 50 mg in 5 mL 150 mM NaCl. 

Store at 4°C. 

 

If a larger volume of the 10 mg/mL IgG stock is prepared, aliquot and store at –20°C 
until use. After the solution has been thawed it should be stored at 4°C. Avoid 
additional freezing and thawing. 

1 mg/mL Streptavidin Stock 
Resuspend 5 mg in 5 mL of PBS.  

Store at 4°C. 

Experiment and Fluidics Station Setup 
Step 1: Defing File Locations 
Before working with Microarray Suite it is important to define where the program stores and looks for files. 

 

For GeneChipTM Operating Software (GCOS), this step is not necessary. Proceed 
directly to Step 2: Entering Experiment Information. 

1. Launch Microarray Suite from the workstation and select Tools → Defaults → File Locations from 
the menu bar. 

The File Locations window displays the locations of the following files: 

• Probe Information (library files, mask files) 

• Fluidics Protocols (fluidics station scripts) 

• Experiment Data (.exp, .dat, .cel, and .chp files are all saved to location selected here) 

2. Verify that all three file locations are set correctly and click OK. Contact Technical Support if you 
have any questions regarding this procedure. 

Step 2: Entering Experiment Information 
To wash, stain, and scan a probe array, an experiment must first be registered in GCOS or Microarray Suite. 
Follow the instructions detailed in the “Setting Up an Experiment” section of the appropriate GCOS or 
Microarray Suite User’s Guide. 

The fields of information required for registering experiments in Microarray Suite are: 

• Experiment Name 

• Probe Array Type 

In GCOS, three additional fields are required: 

• Sample Name 

• Sample Type 

• Project 

Sample templates, Experiment templates, and array barcodes can also be employed in GCOS to standardize 
and simplify the registration process. See the GCOS User’s Guide for more information. 
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The Project, Sample Name, and Experiment Name fields establish a sample hierarchy that organizes 
GeneChip™ gene expression data in GCOS. In terms of the organizational structure, the Project is at the top 
of the hierarchy, followed by Sample Name, and then Experiment Name. 

 

Step 3: Preparing the Fluidics Station 
The Fluidics Station 400, or 450/250 is used to wash and stain the probe arrays. It is operated using 
GCOS/Microarray Suite. 

Setting Up the Fluidics Station 
1. Turn on the Fluidics Station using the switch on the lower left side of the machine. 

2. Select Run → Fluidics from the menu bar. 

The Fluidics Station dialog box appears with a drop-down list for selecting the experiment name for 
each of the fluidics station modules. A second list is accessed for choosing the Protocol for each of the 
four fluidics station modules. 

 

Refer to the appropriate GeneChip™ Fluidics Station User’s Guide for instructions 
on connecting and addressing multiple fluidics stations. 

Priming the Fluidics Station 
Priming ensures that the lines of the fluidics station are filled with the appropriate buffers and the fluidics 
station is ready for running fluidics station protocols. 

Priming should be done: 

• When the fluidics station is first started 

• When wash solutions are changed 

• Before washing if a shutdown has been performed 

• If the LCD window instructs the user to prime 

1. Select Protocol in the Fluidics Station dialog box. 

2. Choose Prime or Prime_450 for the respective modules in the Protocol drop-down list. 

3. Change the intake buffer reservoir A to Non-stringent Wash Buffer and intake buffer reservoir B to 
Stringent Wash Buffer. 

4. For MAS, click Run for each module to begin priming. In GCOS, select the All Modules check box, 
then click Run. 

  



 

84 GeneChip™ Expression Analysis Technical Manual User Guide 

Probe Array Wash and Stain 
Following hybridization, the wash and stain procedures are carried out by the Fluidics Station. A modified 
FlexMidi_euk2v3 fluidics script (FlexMidi_euk2v3_450, if you are using the FS-450) is used for the 
GeneChip™ P. aeruginosa Genome Array, and the ProkGE-WS2 fluidics script (ProkGE-WS2_450, if you are 
using the FS-450) is used for the GeneChip™ E. coli arrays. The procedures take approximately 75 and 90 
minutes, respectively, to complete. The use of streptavidin in the first part of the stain procedure enhances 
the overall signal. 

After 16 hours of hybridization, remove the hybridization cocktail from the probe array and fill the probe 
array completely with the appropriate volume of Non-Stringent Wash Buffer (Wash Buffer A), as given in 
Table D.1. 

 

If necessary, at this point, the probe array can be stored at 4°C for up to 3 hours 
before proceeding with washing and staining. Equilibrate the probe array to room 
temperature before washing and staining. 

Table D.1 Probe Array Cartridge Volumes 

Array Hybridization Volume Total Fill Volume 

49 Format (Standard) 200 µL 250µL 

64 Format 200 µL 250µL 

100 Format (Midi) 130 µL 160µL 

169 Format (Mini) 80 µL 100µL 

400 Format (Micro) 80 µL 100µL 

Preparing the Staining Reagents 
1. Prepare the following stain and wash solutions the day of the procedure. The solutions are stable for 

approximately 6 to 8 hours at 4°C. Volumes given are sufficient for one probe array. 

Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either foil wrapped or kept in 
an amber tube. Remove SAPE from the refrigerator and tap the tube to mix well before preparing 
stain solution. 

Do not freeze SAPE. Always prepare the SAPE stain solution fresh, on the day of use. 

Table D.2 Streptavidin Solution Mix - Vial 1 

Component Volume Final Dilution 

2X Stain Buffer 300.0 µL 1X 

50 mg/mL BSA 24.0 µL 2 mg/mL 

1 mg/mL Streptavidin 6.0 µL 10 µg/mL 

Nuclease-free H20 270.0 µL — 

Total Volume 600 µL  
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Table D.3 Antibody Solution Mix - Vial 2 

Component Volume Final Concentration 

2X MES Stain Buffer 300.0 µL 1X 

50 mg/mL BSA 24.0 µL 2 mg/mL 

10 mg/mL Normal Goat IgG 6.0 µL 0.1 mg/mL 

0.5 mg/mL Anti-streptavidin Antibody, 
biotinylated 

6.0 µL 5 µg/mL 

Nuclease-free H20 264.0 µL — 

Total Volume 600 µL  

Table D.4 SAPE Solution Mix - Vial 3 

Component Volume Final Concentration 

2X MES Stain Buffer 300.0 µL 1X 

50 mg/mL BSA 24.0 µL 2 mg/mL 

1 mg/mL Streptavidin Phycoerythrin 6.0 µL 10 µg/mL 

Nuclease-free H20 270.0 µL — 

Total Volume 600 µL  

2. In the Fluidics Station dialog box on the workstation, select the correct experiment name from the 
drop-down Experiment list. The probe array type will appear automatically. 

Arrays & Fluidics Protocols 

• Array: GeneChip™ E. coli Genome 2.0 Array Protocol: Mini_prok2v1(if using FS-450, 
Mini_prok2v1_450) 

• Array: GeneChip™ E. coli Antisense Genome Array Protocol: ProkGE-WS2 (if using FS-450, 
ProkGE-WS2_450) 

• Array: GeneChip™ P. aeruginosa Genome Array Protocol: Modified FlexMidi_euk2v3* 

(*See Table D.5. If using FS-450, FlexMidi_euk2v3_450) 

 
Fluidics protocols are specific to array format and content. Follow procedures 
below for specific arrays. 

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. Follow the 
instructions in the LCD window on the fluidics station when using the Fluidics Station 400. 

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
refer to the appropriate User’s Guide for your GeneChip™ Fluidics Station 400, or 450/250. 
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Table D.5 Modification of FlexMidi_euk2v3 for GeneChip™ P. aeruginosa Array 

GeneChip™ P. aeurginosa Genome Array requires a modification to the FlexMidi_euk2v3 (or the 
FlexMidi_euk2v3_450) protocol. See below for details. 

The FlexMidi_euk2v3 (or the FlexMidi_euk2v3_450) fluidics protocol must be modified. Follow the 
instructions carefully to make the modifications. Additionally, it is highly recommended that you save 
your new P. aeruginosa fluidics protocol under a different name to avoid confusion. 

1. Modify and save the fluidics protocol for the assay: 

a. Modify the fluidics protocol by using Tools → Edit Protocol drop-down list and selecting 
FlexMidi_euk2v3 (or the FlexMidi_euk2v3_450) within the Protocol Name window. 

b. Change the following parameters: (Enter the new parameters by highlighting the default values 
and typing in the new values.) 

i. Wash A1 Temperature from 30°C to 25°C; 

ii. Number of Wash B Cycles from 6 to 4; 

iii. Stain Temperature (C) from 35°C to 25°C; 

iv. First Stain Time seconds) from 300 to 600 seconds; 

v. Second Stain Time (seconds) from 300 to 600 seconds; 

vi. Third Stain Time (seconds) from 300 to 600 seconds; and 

vii. Wash A3 Temperature from 35°C to 30°C. 

c. Save the modified fluidics protocol by highlighting FlexMidi_euk2v3 (or the 
FlexMidi_euk2v3_450) within the Protocol Name window and typing over with an assigned 
protocol name (e.g., Pae_cDNA). Click Save. 

The new fluidics protocol should be present in the Protocol drop-down list and is used in the 
subsequent steps. 

2. Select the name of the newly modified protocol (e.g., Pae_cDNA) from the Protocol drop-down list 
in the Fluidics Station dialog box. Select Run in the Fluidics Station dialog box to begin the washing 
and staining. Follow the instructions in the LCD window on the fluidics station. 

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
refer to the appropriate User’s Guide for your GeneChip™ Fluidics Station 400, or 450/250. 

Table D.6 Fluidics Scripts Prokaryotic Arrays 

Format Fluidics Scripts* 

169 Mini_prok2v1 

100 modified FlexMidi_Euk2v3 

49 ProkGE_WS2 

*When using the Fluidics Station 450 or 250 add _450 at the end of the fluidics script’s name. 
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Table D.7 Fluidics Protocols 

 Mini_prok2v1* FlexMidi_euk2v3† Modified 
FlexMidi_euk2v3 
for P. aeruginosa 
Array 

ProkGE_WS2‡ 

Post Hyb 
Wash #1 

10 cycles of 2 
mixes/ cycle with 
Wash Buffer A at 
30°C 

10 cycles of 2 mixes/ 
cycle with Wash Buffer 
A at 30°C 

10 cycles of 2 
mixes/cycle with 
Wash Buffer A at 
25°C 

10 cycles of 2 
mixes/ cycle with 
Wash Buffer A at 
25°C 

Post Hyb 
Wash #2 

4 cycles of 15 
mixes/ cycle with 
Wash Buffer B at 
50°C 

6 cycles of 15 mixes/ 
cycle with Wash Buffer 
B at 50°C 

4 cycles of 15 
mixes/cycle with 
Wash Buffer B at 
50°C 

4 cycles of 15 
mixes/ cycle with 
Wash Buffer B at 
45°C 

1st Stain Stain the probe 
array for 300 
seconds in 
Streptavidin 
Solution Mix at 
35°C 

Stain the probe array 
for 300 seconds in 
SAPE Solution Mix at 
35°C 

Stain the probe 
array for 600 
seconds in 
Streptavidin 
Solution Mix at 
25°C 

Stain the probe 
array for 600 
seconds in 
Streptavidin 
Solution Mix at 
25°C. 

Post Stain 
Wash 

10 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
30°C 

10 cycles of 4 mixes/ 
cycle with Wash Buffer 
A at 30°C 

10 cycles of 4 
mixes/cycle with 
Wash Buffer A at 
30°C 

10 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
30°C 

2nd Stain Stain the probe 
array for 300 
seconds in 
Antibody Solution 
Mix at 35°C 

Stain the probe array 
for 300 seconds in 
Antibody Solution Mix 
at 35°C 

Stain the probe 
array for 600 
seconds in 
Antibody 
Solution Mix at 
25°C 

Stain the probe 
array for 600 
seconds in 
Antibody Solution 
Mix at 25°C. 

3rd Stain Stain the probe 
array for 300 
seconds in SAPE 
Solution Mix at 
35°C 

Stain the probe array 
for 300 seconds in 
SAPE Solution Mix at 
35°C 

Stain the probe 
array for 600 
seconds in SAPE 
Solution Mix at 
25°C 

Stain the probe 
array for 600 
seconds in SAPE 
Solution Mix at 
25°C. 

Final 
Wash 

15 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
35°C. The holding 
temperature is 25°C 

15 cycles of 4 mixes/ 
cycle with Wash Buffer 
A at 35°C. The holding 
temperature is 25°C. 

15 cycles of 4 
mixes/cycle with 
Wash Buffer A at 
30°C. The 
holding 
temperature is 
25°C. 

15 cycles of 4 
mixes/ cycle with 
Wash Buffer A at 
30°C. The holding 
temperature is 
s25°C. 

*Mini_prok2v1_450 fot the FS-450/250 
†FlexMidi_Euk2v3_450 for the FS-450/250 
‡ProkGE_WS2_450 for the FS-450/250 
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Using the Fluidics Station 450/250  

Washing and Staining the Probe Array 
1. In the Fluidics Station dialog box on the workstation, select the correct experiment name from the 

drop-down Experiment list. 

The Probe Array Type appears automatically. 

2. In the Protocol drop-down list, select the appropriate antibody amplification protocol to control the 
washing and staining of the probe array format being used: Table D.6. 

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. Follow the 
instructions in the LCD window on the fluidics station. 

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
refer to the appropriate Fluidics Station User’s Guide, or Quick Reference Card (P/N 08-0093 for the FS-
450/250 fluidics stations). 

4. Insert the appropriate probe array into the designated module of the fluidics station while the 
cartridge lever is down, or in the eject position. When finished, verify that the cartridge lever is 
returned to the up, or engaged, position. 

5. Remove any microcentrifuge vial(s) remaining in the sample holder of the fluidics station module(s) 
being used. 

6. If prompted to “Load Vials 1-2-3,” place the three experiment sample vials (the microcentrifuge 
vials) into the sample holders 1, 2, and 3 on the fluidics station. 

a. Place one vial containing streptavidin solution in sample holder 1. 

b. Place one vial containing the anti-streptavidin biotinylated antibody solution in sample holder 2. 

c. Place one vial containing the streptavidin phycoerythrin (SAPE) solution in sample holder 3. 

d. Press down on the needle lever to snap needles into position and to start the run. 

The run begins. The Fluidics Station dialog box at the workstation terminal and the LCD window 
display the status of the washing and staining as the protocol progresses. 

7. When the protocol is complete, the LCD window displays the message EJECT CARTRIDGE. 

8. Remove the probe arrays from the fluidics station modules by first pressing down the cartridge lever 
to the eject position. 

9. Lift up on the needle lever to disengage the needles from the microcentrifuge vials. Remove the three 
microcentrifuge vials from the needle holders. 

10. Check the probe array window for large bubbles or air pockets. 

• If bubbles are present, refer to Table D.8. 

• If the probe array has no large bubbles, it is ready to scan on the GeneArray™ Scanner, or the 
GeneChip™ Scanner 3000. Pull up on the cartridge lever to close the washblock and proceed to 
Probe Array Scan. 

11. If there are no more samples to hybridize, shut down the fluidics station following the procedure in 
Shutting Down the Fluidics Station. 

12. Keep the probe arrays at 4°C and in the dark until ready for scanning. 

13. Lift up on the cartridge lever to close the washblock. 

 

For proper cleaning and maintenance of the fluidics station, including the 
bleach protocol, refer to the appropriate GeneChip™ Fluidics Station 
User’s Guide for instruction. 
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Table D.8 If Bubbles Are Present 

Return the probe array to the probe array holder. Engage the washblock by gently pushing up on the 
cartridge lever to the engage position. 
The fluidics station will drain the probe array and then fill it with a fresh volume of the last wash buffer 
used. When it is finished, the LCD window will display EJECT CARTRIDGE. Again, remove the probe 
array and inspect it for bubbles. If no bubbles are present, it is ready to scan. Proceed to Probe Array 
Scan. 
If several attempts to fill the probe array without bubbles are unsuccessful, the array should be filled 
with Wash Buffer A (non-stringent buffer) manually, using a micropipette. Excessive washing will 
result in a loss of signal intensity. 

Using the Fluidics Station 400  

Washing and Staining the Probe Array 
1. In the Fluidics Station dialog box on the workstation, select the correct experiment name in the drop-

down Experiment list. The probe array type will appear automatically. 

2. In the Protocol drop-down list, select the appropriate antibody amplification protocol to control the 
washing and staining of the probe array format being used: Table D.6. 

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. Follow the 
instructions on the LCD window on the fluidics station. 

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
refer to the Fluidics Station 400 User’s Guide, Fluidics Station 400 Video In-Service CD (Pub. No. 900374), 
or Quick Reference Card (Pub. No. 08-0072). 

4. Insert the appropriate probe array into the designated module of the fluidics station while the 
cartridge lever is in the EJECT position. When finished, verify that the cartridge lever is returned to 
the ENGAGE position. 

5. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station module(s) 
being used. 

6. Place a microcentrifuge tube containing the streptavidin solution into the sample holder, making 
sure that the metal sampling needle is in the tube with its tip near the bottom 

The Fluidics Station dialog box and the LCD window display the status of the washing and staining 
as they progress. 

7. When the LCD window indicates, replace the microcentrifuge vial containing the streptavidin stain 
with a microcentrifuge vial containing antibody stain solution into the sample holder, making sure 
that the metal sampling needle is in the vial with its tip near the bottom. 

8. When the LCD window indicates, replace the microcentrifuge vial containing antibody solution with 
the microcentrifuge vial containing the streptavidin phycoerythrin (SAPE) solution. 

9. When the protocol is complete, the LCD window displays the message EJECT CARTRIDGE. 

10. Remove microcentrifuge vial containing stain and replace with an empty microcentrifuge tube. 

11. Remove the probe arrays from the fluidics station modules by first moving the cartridge lever to the 
EJECT position. 

12. Check the probe array window for large bubbles or air pockets. 

• If bubbles are present, refer to Table D.9. 

• If the probe array has no large bubbles, it is ready to scan on the GeneChip™ Scanner 3000 or the 
GeneArray™ Scanner. ENGAGE washblock and proceed to Probe Array Scan. 
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If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark until ready for 
scanning. 

If there are no more samples to hybridize, shut down the fluidics station following the procedure 
outlined in the section, Shutting Down the Fluidics Station. 

 

For proper cleaning and maintenance of the fluidics station, including the 
bleach protocol, refer to the appropriate GeneChip™ Fluidics Station 
User’s Guide for instruction. 

Table D.9 If Bubbles Are Present 

Return the probe array to the probe array holder. Latch the probe array holder by gently pushing it 
up until a light click is heard. Engage the washblock by firmly pushing up on the cartridge lever to 
the ENGAGE position. 
The fluidics station will drain the probe array and then fill it with a fresh volume of the last wash 
buffer used. When it is finished, the LCD window displays EJECT CARTRIDGE again, remove the 
probe array and inspect it again for bubbles. If no bubbles are present, it is ready to scan. Proceed to 
Probe Array Scan. 
If several attempts to fill the probe array without bubbles are unsuccessful, the array should be 
filled with Wash Buffer A (non-stringent buffer) manually, using a micropipette. Excessive 
washing will result in a loss of signal intensity. 

Probe Array Scan 
The scanner is also controlled by Microarray Suite or GCOS. The probe array is scanned after the wash 
protocols are complete. Make sure the laser is warmed up prior to scanning by turning it on at least 15 
minutes before use if you are using the Agilent GeneArray™ Scanner, or 10 minutes if you are using the 
GeneChip™ Scanner 3000. If the probe array was stored at 4°C, warm to room temperature before 
scanning. Refer to the Microarray Suite or GCOS online help and the appropriate scanner user’s manual for 
more information on scanning. 

 
The scanner uses a laser and is equipped with a safety interlock system. 
Defeating the interlock system may result in exposure to hazardous 
laser light. 

 

 
You must have read and be familiar with the operation of the scanner before 
attempting to scan a probe array. Refer to the Microarray Suite User’s Guide 
(P/N 08-0081) or to the GeneChip™ Scanner 3000 quick reference card (P/N 
08-0075). 
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Handling the GeneChip™ Probe Array 
Before you scan the probe array, follow the directions in this section on handling the probe array. If 
necessary, clean the glass surface of the probe array with a non-abrasive towel or tissue before scanning. Do 
not use alcohol to clean glass. 

Before scanning the probe array cartridge, follow this procedure to apply Tough-Spots™ to the probe array 
cartridge to prevent the leaking of fluids from the cartridge during scanning. 

 
Apply the spots just before scanning. Do not use them in the hyb process. 

1. On the back of the probe array cartridge, clean excess fluid from around septa. 

2. Carefully apply one Tough-Spot to each of the two septa. Press to ensure that the spots remain flat. If 
the Tough-Spots do not apply smoothly; that is, if you observe bumps, bubbles, tears or curled edges, 
do not attempt to smooth out the spot. Remove the spot and apply a new spot. See Figure D.1. 

Figure D.1 Applying Tough-Spots™ to the Probe Array Cartridge 

 

3. Insert the cartridge into the scanner and test the autofocus to ensure that the Tough-Spots do not 
interfere with the focus. If you observe a focus error message, remove the spot and apply a new spot. 
Ensure that the spots lie flat. 

Scanning the Probe Array 
1. Select Run → Scanner from the menu bar. Alternatively, click the Start Scan icon in the tool bar. 

The Scanner dialog box appears with a drop-down list of experiments that have not been run. 

2. Select the experiment name that corresponds to the probe array to be scanned. 

A previously run experiment can also be selected by using the Include Scanned Experiments option 
box. After selecting this option, previously scanned experiments appear in the drop-down list. 

3. By default, for the Agilent™ GeneArray™ Scanner only, after selecting the experiment the number 
[2] is displayed in the Number of Scans box to perform the recommended 2X image scan. For the 
GeneChip™ Scanner 3000, only one scan is required. 

4. Once the experiment has been selected, click the Start button. 

A dialog box prompts you to load a sample into the scanner. 

5. If you are using the GeneArray™ Scanner, click the Options button to check for the correct pixel 
value and wavelength of the laser beam. 

• Pixel value = 3 µm 

• Wavelength = 570 nm 

If you are using the GeneChip™ Scanner 3000, pixel resolution and wavelength are preset and 
cannot be changed. 
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6. Open the sample door on the scanner and insert the probe array into the holder. Do not force the 
probe array into the holder. Close the sample door of the scanner. If you are using the GeneChip™ 
Scanner 3000, do not attempt to close the door by hand. The door closes automatically through the 
User Interface when start scan is selected or the scanner goes into stand-by mode. 

7. Click OK in the Start Scanner dialog box. 

The scanner begins scanning the probe array and acquiring data. When Scan in Progress is Selected 
from the View menu, the probe array image appears on the screen as the scan progresses. 

Shutting Down the Fluidics Station 
1. After removing a probe array from the probe array holder, the LCD window displays the message 

ENGAGE WASHBLOCK. 

2. If you are using the FS-400, latch the probe array holder by gently pushing up until a light click is 
heard. Engage the washblock by firmly pushing up on the cartridge lever to the ENGAGE position. 

If you are using the FS-450, gently lift up the cartridge lever to engage, or close, the washblock. 

The fluidics station automatically performs a Cleanout procedure. The LCD window indicates the 
progress of the Cleanout procedure. 

3. When the fluidics station LCD window indicates REMOVE 

VIALS, the Cleanout procedure is complete. 

4. Remove the sample microcentrifuge vial(s) from the sample holder(s). 

5. If no other hybridizations are to be performed, place wash lines into a bottle filled with deionized 
water. 

6. Select Shutdown or Shutdown_450 for all modules from the drop-down Protocol list in the Fluidics 
Station dialog box. Click the Run button for all modules. 

The Shutdown protocol is critical to instrument reliability. Refer to the appropriate Fluidics Station 
User’s Guide for more information. 

7. After Shutdown protocol is complete, flip the ON/OFF switch of the fluidics station to the OFF 
position. 

 To maintain the cleanliness of the fluidics station and obtain the highest quality 
image and data possible, a weekly bleach protocol and a monthly decontamination 
protocol are highly recommended. Refer to the appropriate GeneChipTM Fluidics 
Station User’s Guide for further detail. 

Customizing the Protocol 
There may be times when the fluidics protocols need to be modified. Modification of protocols must be 
done before downloading the protocol to the fluidics station. Protocol changes will not affect runs in 
progress. For more specific instructions, refer to the Microarray Suite/ GCOS online help. 

1. Select Tools → Edit Protocol from the menu bar. 

2. In the Edit Protocol dialog box under Protocol Name, click the arrow to open a list of protocols. Click 
the protocol to be changed. 

The name of the protocol is displayed in the Protocol Name text box. The conditions for that protocol 
are displayed on the right side of the Edit Protocol dialog box. 

3. Select the items to be changed and input the new parameters as needed, keeping parameters within 
the ranges shown in Table D.10. 
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Table D.10 Valid Ranges for Wash/Stain Parameters 

Parameter  Valid Range 

Wash Temperature for A1, B, A2, or A3 (°C) 15 to 50 

Number of Wash Cycles for A1, B, A2, or A3 0 to 99 

Mixes / Wash Cycle for A1, B, A2, or A3 1 to 99 

Stain Time (seconds) 0 to 86,399 

Stain Temperature (°C) 15 to 50 

Holding Temperature (°C) 15 to 50 

• Wash A1 corresponds to Post Hyb Wash #1 in Table D.7. 
• Wash B corresponds to Post Hyb Wash #2 in Table D.7. 
• Wash A2 corresponds to Post Stain Wash in Table D.7. 
• Wash A3 corresponds to Final Wash in Table D.7. 

4. To return to the default values for the protocol selected, click the Defaults button. 

5. Once all the protocol conditions are modified as desired, change the name of the edited protocol in 
the Protocol Name box. 

 
If the protocol is saved without entering a new “Protocol Name,” the 
original protocol parameters will be overwritten. 

6. Click Save, then close the dialog box. 

Enter 0 (zero) for hybridization time if hybridization step is not required. Likewise, enter 0 (zero) for 
the stain time if staining is not required. Enter 0 (zero) for the number of wash cycles if a wash step is 
not required. 
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Appendix E List of Controls on GeneChip™ Probe 
Arrays 

Control Genes on GeneChip™ Eukaryotic Probe Arrays 
Table E.1 Control Genes on GeneChip™ Eukaryotic Probe Arrays 

Origin of Organism Control Gene Name Utility for 
GeneChipTM 
Experiments 

Associated Products 

synthetic B2 Oligo Grid alignment. Control Oligo B2, P/N 900301, 
also as part of the Hybridization 
Control Kit P/N 900454 or 
900457 

E. coli bioB Antisense 
biotinylated cRNA 
are used as 
hybridization 
controls. 

GeneChip™ Eukaryotic 
Hybridization Control Kit, P/N 
900454 or 
P/N 900457 

bioC 

bioD 

P1 Bacteriophage cre 

B. subtilis lys Poly-A-tailed 
sense RNA can be 
spiked into 
isolated RNA 
samples as 
controls for the 
labeling and 
hybridization 
process. The spikes 
can also be used to 
estimate assay 
sensitivity. 

GeneChip™ Eukaryotic Poly-A 
RNA Control Kit, P/N 900433 phe 

thr 

dap 

Control Genes on GeneChip™ Prokaryotic Probe Arrays 
Table E.2 Control Genes on GeneChip™ Prokaryotic Probe Arrays 

Origin of Organism Control Gene Name Utility for GeneChip™ 
Experiments 

Associated Products 

synthetic B2 Oligo Grid alignment. Control Oligo B2, P/N 
900301, also as part of the 
Hybridization Control Kit 
P/N 900454 or 900457 

B. subtilis lys 
phe 
thr 
dap 

Sense RNA can be spiked 
into purified sample 
RNA as control for the 
labeling and 
hybridization process. 
The spikes can also be 
used to estimate assay 
sensitivity. 

GeneChip™ Eukaryotic 
Poly-A RNA Control Kit, 
P/N 900433 
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Appendix F Contact Information 

Supplier Contact Information 
Table F.1 

Supplier Website 

Amersham Biosciences  www.amershambiosciences.com 

Amresco www.amresco-inc.com  

BD Biosciences www.bdbiosciences.com 

BioWhittaker Molecular Applications / Cambrex www.cambrex.com  

Brinkmann Instruments www.brinkmann.com  

Cole-Parmer www.coleparmer.com  

Corning Life Sciences www.corning.com/lifesciences/ 

CLONTECH www.bdbiosciences.com/clontech/ 

Epicentre Technologies www.epicentre.com  

Eppendorf www.eppendorf.com  

Millipore Corp (MilliporeSigma) www.millipore.com  

New England Biolabs www.neb.com  

Novagen (MilliporeSigma) www.emdbiosciences.com 

Promega Corporation www.promega.com  

Proligo (MilliporeSigma) www.gensetoligos.com  

QIAGEN www.qiagen.com  

Rainin www.rainin.com 

Roche Diagnostics www.roche-applied-science.com 

Sigma-Aldrich (MilliporeSigma) www.sigma-aldrich.com  

USA Scientific www.usascientific.com  

Vector Laboratories www.vectorlabs.com  

VWR Scientific Products www.vwrsp.com  

  

http://www.amershambiosciences.com/
http://www.amresco-inc.com/
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.bdbiosciences.com
http://www.cambrex.com/
http://www.brinkmann.com/
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.coleparmer.com
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.corning.com/lifesciences/
http://www.bdbiosciences.com/clontech/
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.epicentre.com
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.eppendorf.com
http://www.millipore.com/
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.neb.com
http://www.emdbiosciences.com/
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.promega.com
http://www.gensetoligos.com/
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.qiagen.com
http://www.rainin.com/
http://www.roche-applied-science.com/
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.sigma-aldrich.com
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.usascientific.com
file://cbfile2.ads.invitrogen.net/shared/Marketing/Technical%20Writers/Rebranding_Affy_IIb_Q3_2018/MAN0018111/02_QA_InProgress/www.vectorlabs.com
http://www.vwrsp.com/
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Documentation and support 
 

 

Customer and 
technical support 

For the latest services and support information for all locations, visit 
www.thermofisher.com. 

At the website, you can: 

• Access worldwide telephone and fax numbers to contact Technical Support 
and Sales facilities 

• Search through frequently asked questions (FAQs) 

• Submit a question directly to Technical Support (thermofisher.com/support) 

• Search for user documents, SDSs, vector maps and sequences, application 
notes, formulations, handbooks, certificates of analysis, citations, and other 
product support documents 

• Obtain information about customer training 

• Download software updates and patches 

Safety Data 
Sheets (SDS) 

Safety Data Sheets (SDSs) are available at thermofisher.com/support.  

Limited product 
warranty 

Life Technologies Corporation and/or its affiliate(s) warrant their products as set 
forth in the Life Technologies’ General Terms and Conditions of Sale found on 
Life Technologies’ website at www.thermofisher.com/us/en/home/global/terms-
and-conditions.html. If you have any questions, please contact Life Technologies 
at www.thermofisher.com/support. 

 

http://www.lifetechnologies.com/
http://www.thermofisher.com/support
http://www.thermofisher.com/support
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/support


 

thermofisher.com/support | thermofisher.com/askaquestion  

thermofisher.com  

30 November 2018 

 

http://thermofisher.com/support
http://thermofisher.com/askaquestion
http://thermofisher.com/
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